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Frontispiece. Strained quartz cobble conglomerate at Sandviksfjellet, Bergen, Norway. The 
formation is folded and highly deformed, here prolate, cigar-shaped, cobbles indicate a strong 
constrictional strain (Holst and Fossen, 1987; Fossen, 1988). Photograph by E. Lubicich.
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License and Citation
License

EllipseFit software and accompanying documentation are Copyright © Frederick W. Vollmer. They 
come with no warrantees or guarantees of any kind. The software is free and may be downloaded and 
used without cost, however the author retains all rights to the source, binary code and accompanying 
files. It may not be redistributed or posted online. The only stipulation for usage is that citation be 
given for any usage that leads to publications or presentations.

This software and any related documentation are provided "as is" without warranty of any kind, either 
express or implied, including, without limitation, the implied warranties or merchantability, fitness for 
a particular purpose, or non-infringement. The entire risk arising out of use or performance of the 
software remains with you. 

Citation

EllipseFit is the result of countless hours of work over several decades. Algorithms used in the program
come from numerous sources, however many have been developed by the author, some of which have 
not yet been published and are the subject of papers in preparation. The program is released publicly 
with the hope that the structure and tectonics community will find it useful, and ask forgiveness for the 
limited documentation, as well as respect for publication priority.

In return for free use, any significant use of the software in digitizing, analyzing data, or preparing 
diagrams must be cited in publications, presentations, or other works. Please cite:

Vollmer, F. W., 2017. EllipseFit: Strain and Fabric Analysis Software Version 3.4.0 [computer software]. Retrieved from 
http://www.frederickvollmer.com/ellipsefit/.

A citation might be, for example, “The software EllipseFit (Version 3.4.0; Vollmer, 2017) was used for 
the strain analysis.” 

Additionally, references to techniques or methodologies presented in this User Manual should cite:

Vollmer, F. W., 2017. EllipseFit: Strain and Fabric Analysis Software User Manual Version 3.4.0 [computer software user 
manual]. Retrieved from http://www.frederickvollmer.com/ellipsefit/.

One or more of the following may be appropriate for specific techniques:

Vollmer, F. W., 2010. A comparison of ellipse-fitting techniques for two and three-dimensional strain analysis, and their 
implementation in an integrated computer program designed for field-based studies. Abstract T21B-2166, Fall Meeting,
American Geophysical Union, San Francisco, California. [for EllipseFit or implementation of Shawn’s method, Section
6.3]

Vollmer, F. W., 2011. Automatic contouring of two-dimensional finite strain data on the unit hyperboloid and the use of 
hyperboloidal stereographic, equal-area and other projections for strain analysis. Geological Society of America 
Abstracts with Programs, v. 43, n. 5, p. 605. [for use of hyperboloidal contouring, Section 5.2.3]

Vollmer, F. W., 2011. Best-fit strain from multiple angles of shear and implementation in a computer program for geological
strain analysis. Geological Society of America Abstracts with Programs, v. 43. [for use of the automated Wellman 
method, Section 4.1)] 

Registration

Please consider registering the software, registration is free and helps me determine the software usage 
and justify the time spent in it's upkeep. To register, simply send an email to me at 
vollmerf@gmail.com with your user name, affiliation, and usage. I will send you an email in reply with

http://www.frederickvollmer.com/ellipsefit/
mailto:vollmerf@gmail.com
http://www.frederickvollmer.com/ellipsefit/


my thanks, and will not place you on a mailing list. For example, send me an email with something 
like:

User: Frederick Vollmer
Affiliation: SUNY New Paltz, Geology Department
Usage: Undergraduate structural geology course and research

The author is happy to take emails with questions and suggestions, either at the university (SUNY New
Paltz) or at the gmail address used on his website. However he is not reliable about checking email, so 
please forgive him if he is slow in answering, he will try to respond in as timely a fashion as possible. 
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1. Introduction
EllipseFit is an integrated program for geological fabric and strain analysis. It is used for determining 
two and three-dimensional strain from oriented photographs, and is designed for field and laboratory 
based structural geology studies. The graphical interface and multi-platform deployment also make it 
ideal for introductory or advanced structural geology laboratories. The software is used at numerous 
universities, including the author’s home institution, SUNY New Paltz, where hundreds of students 
have used it in laboratory and field studies. EllipseFit is currently implemented for Windows, 
Macintosh, and Linux platforms. 

EllipseFit is suitable for determining two- and three-dimensional strain using various objects including 
center points (Fry analysis), lines, ellipses, and polygons. Polygons include ooids, pebbles, fossils, or 
particles of any initial shape, so is widely applicable to many rocks in thin section, hand sample, or 
outcrop. EllipseFit allows digitizing polygons directly, or indirectly using a flood fill method. The 
polygons are converted into moment-equivalent ellipses, which can be analyzed using standard ellipse 
calculations. Given three or more oriented sections EllipseFit can calculate the three dimensional strain.

EllipseFit was initially released in 1989, in part based on older Fortran code written on punch cards for 
Win Means, EllipseFit 2 was a full rewrite released in 2011. It was widely used, including for a 
workshop at the 2012 Structural Geology and Tectonics Forum at Williams College. The compiler was 
chosen for easy cross-platform (Windows, Mac, and Linux) development, however poor performance 
and support led to a full rewrite, EllipseFit 3, in 2014. EllipseFit 3 was used for a strain workshop at the
2014 Structural Geology and Tectonics Forum, at the Colorado School of Mines with Paul Karabinos 
and Matty Mookerjee, and has been adopted at many universities for teaching and research. Version 3 
has had a dozen updates with major new features, as well as minor feature additions and bug fixes. 
User input is very helpful for such bug fixes and feature requests.

The author is a professor of structural geology, who has taught for over 30 years at SUNY New Paltz. 
He had the luck to be introduced to analytical structural geology as a student, and is grateful to mentors
Rob Twiss at UC Davis, Win Means at SUNY Albany, and Peter Hudleston at U Minnesota whose clear
thinking inspired him. He was introduced to programming as a grade school student, when his dear 
mother required him to take a summer school course. He subsequently joined the Computer Club, one 
of three members, spent countless hours on a terminal connected remotely to a mainframe, and became 
obsessed with coding. 

1.1 Installation
On Macintosh OS X, double click the disk image file (dmg), and drag the EllipseFit application to your
Applications folder, or another desired location, such as a new folder EllipseFit within the Application 
folder. The User Manual and Example Data folder can then also be copied to the same location.

On Windows, unzip the zip file using the Extract All option, and drag the EllipseFit application to any 
desired location. Make sure to entirely extract EllipseFit from the zip file, this is the most common 
installation problem. The User Manual and Example Data folder can also be copied to the same 
location.
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On Linux unpack the tar file (tgz), and copy EllipseFit to any desired location. The User Manual and 
Example Data folder can also be copied to the same location.   

The Example Data folder contains example data and images to show how data is formatted, these are 
referred to in this guide. After installing a new version, if any problems arise, you may need to reset the
preferences using the Reset Preferences command in the Help menu. Alternatively, start EllipseFit 
while holding down the Option (or Alt) key. This will reset the preferences to default values. The 
preferences are stored in the file EllipseFit3.xml, which is located in the folder EllipseFit in your 
operating system's application preferences folder. To deinstall simply delete the EllipseFit application, 
and optionally delete the preference folder. No other files are installed on your computer. No 
administrative permissions are required to install EllipseFit, and it is possible to keep a copy on a 
thumb drive to run on any computer. 

1.2 Overview of Strain Analysis
When attempting to unravel the origins of geologic structures and mountain belts, one starts with a 
hand sample or single outcrop. The lithology, textures, and mineralogy give clues about their 
sedimentary, igneous, and metamorphic history. Geologists have devised numerous additional 
techniques, such as high resolution chemical and isotopic analyses, paleomagnetism, and 
geochronology, to extract additional information, these are commonly used in concert to piece together 
the Earth’s history and inner workings. Finite strain analysis is one such technique that is used to 
unravel the deformation history, a critical piece of the puzzle. 

Geological strain analysis and theory is an important aspect of structural geology that is covered in 
numerous textbooks (e.g., Means, 1976; Hobbs, Means, and Williams, 1976; Ragan, 1985; Marshak 
and Mitra, 1988; Van der Pluijm and Marshak, 2004; Pollard and Fletcher, 2005; Twiss and Moores, 
2007; Ragan, 2009; Davis et al., 2011; Fossen, 2016). Ragan (2009) and Ramsay and Huber (1983) 
provide excellent overviews of techniques for the analysis of strain in deformed rocks. 

Strain markers can be grouped into three general categories (Ramsay and Huber, 1983; Lisle, 2010; 
Mulchrone, 2013): 

    Points - Collections of objects whose spacial arrangement defines a fabric.
    Geometric - Objects or groups of objects with known pre-strain geometries.
    Ellipses - Objects whose shapes can be approximated by ellipses.

The first includes Fry (Fry, 1979) and nearest neighbor (Ramsay, 1967) methods. These are based on 
the assumption of an initially random or uniform distribution of particles, with a cutoff distance, 
generally twice the average particle radius. Points are the simplest type of data, however, as discussed 
in Chapter 3, it can be difficult to objectively extract strain from point distributions. EllipseFit includes 
numerous procedures for this type of analysis (Section 2.2.2, Chapter 3). 

Geometric methods apply to fossils and other objects of known pre-strain geometry, including angular 
measurements, to which equations of finite strain can be applied (e.g., Ramsay, 1967; Ramsay and 
Huber, 1983; Ragan, 2009). These techniques are useful for specific locations or samples (e.g., 
Wellman, 1966; Waldon, 1988), but are less broadly applicable. The analysis of line data depends on 
the known initial lengths of, or angles between, lines, and has important applications for some data as 
discussed in Chapter 4. EllipseFit implements an analytical Wellman method (Sections 2.2.3 and 4.1; 
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Vollmer, 2011), and a method where multiple line stretches, such as from folds and boudins, are known 
(Section 4.2). 

Ellipse methods apply to samples such as sandstones and conglomerates, as well as collections of 
irregular clasts or fossils (Mulchrone and Choudhury, 2004), so these techniques are broadly 
applicable. EllipseFit provides numerous procedures for ellipse data collection, plotting, and analysis 
(Sections 2.2.4, 2.2.5, 2.2.6, and Chapter 5). Ellipse and polygon data is collected assuming that 
particles, such as sand grains, initially approximated a collection of random ellipsoids or polyhedra. 
Graphical techniques for two-dimensional strain plots, including Rf / ϕ plots and Elliott polar plots are 
discussed in this chapter (Section 5.2). The properties of these can be understood by recognizing them 
as hyperboloidal projections, which are analogous to spherical projections used to create stereonets 
(Wulff nets) and Schmidt nets. Other hyperboloidal projections also have useful properties for strain 
analysis. This chapter also covers data contouring (Section 5.3), calculation of mean ellipses (Section
5.4), and error analysis (Section 5.5).

Chapter 6 covers the more complex steps involved in determining three-dimensional strain ellipsoids 
from oriented sections for which the two-dimensional strain ellipse has been determined. This chapter 
also covers strain plots used to display ellipsoid data, Flinn and Hsü-Nadia plots.

Chapter 7 discuses methods for transforming data sets, including unstraining or retrodeforming data 
sets and images to their pre-deformation state. Chapter 8 covers data synthesis for making artificial 
samples from random populations. Chapter 9 discusses image analysis techniques, including filtering 
and edge finding, that can aid in highlighting particle edges prior to digitizing.

It is essential to be aware of the assumptions involved in strain analysis. In general, a sample of 
particles can be analyzed to determine a rock fabric, but interpreting the fabric as a strain requires 
certain assumptions to be made, which may be difficult to evaluate. Refer to the referenced texts for a 
complete discussion. One important consideration is whether particles, such as fossils or clasts, record 
the same deformation as the rock. In particular, this may not be true if there was a viscosity contrast 
between the particles and the matrix that encloses them. Using both point and ellipse methods may help
to resolve this. 

A second problem to consider is whether there was an initial preferred orientation of particles, such as 
a primary fabric due to sedimentation or compaction. Unimodal, or orthogonal, sedimentary fabrics are 
equivalent to a homogeneous transformation that is indistinguishable from a tectonic strain. 
Mathematically, the superposition of two homogeneous transformations results in a homogeneous 
transformation, which it is impossible to decompose without additional information. Detection of initial
fabrics is discussed briefly in Section 5.2.3. Similarly, volume change, or dilatation, is difficult to 
quantify, and is often assumed to be zero. This may not be correct, but it does not effect the 
measurement of strain ratios, the most common measure of deformation.  
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2. Data Types and Entry
EllipseFit includes procedures for complete fabric and strain analyses, including image processing, 
digitizing, calculation of two-dimensional sectional ellipses, and combination of sections to obtain 
three-dimensional ellipsoids. Each data file represents a sample of particle measurements that define a 
fabric which can be analyzed in various ways. The fabric, if certain important assumptions are met, can
be interpreted as a strain associated with tectonic deformation. The fabric, however, may also have 
formed due to primary sedimentary or igneous processes, or may be a combination of primary and 
tectonic fabrics. It can be difficult, or even impossible, to factor out the effects of primary versus 
tectonic fabrics. The design and goals of the investigation will determine which of these is of interest, 
and what assumptions can be made about their relative effects on the fabric.  

Data can be entered directly by digitizing images in EllipseFit, or by importing data from another 
application, such as ImageJ or MATLAB. Additionally, while EllipseFit includes options for image 
analysis, such as thresholding, it may be desirable to preprocess images in other software, such as 
Photoshop, GIMP, Illustrator, or Inkscape, such as when it is necessary to manually outline polygonal 
grains for analysis using the polygon fill routine covered in Section 2.2.6. 

2.1 Data Files
EllipseFit files are saved in simple spreadsheet formats compatible with spreadsheet software such as 
Microsoft Excel and LibreOffice Calc. EllipseFit reads and writes a variety of formats, including 
comma separated (csv), tab separated (tsv or txt), LibreOffice Open Document (ods), and Excel (xlsx) 
formats. This allows keeping data in standard or non-proprietry formats for archiving data sets. Tab 
separated value (tsv) files have a particularly simple text format, and can be opened in any text or word
processing program, so are recommended for archiving. 

In addition to standard spreadsheet files, it is possible to export crystal size distribution (csd) files, a 
special format that is commonly used to analyze fabrics defined by crystals in igneous rocks, which can
provide insight on igneous solidification processes. Using EllipseFit for data collection can provide a 
workflow that is more rapid than using, for example, first Photoshop or GIMP to outline images, and 
then ImageJ or MATLAB to calculate ellipses. 

2.1.1 Spreadsheet Files

EllipseFit reads and writes a variety of formats, including comma separated (csv), tab separated (tsv or 
txt), LibreOffice Open Document (ods), and Excel (xlsx) formats. In addition to lines of data, each file 
must include a simple one line header, which indicates the type of data in each column. By default, all 
angles are in degrees, it is not recommended that this be changed to radians or gradians unless that is 
standardized for a laboratory or project. Comments may be included to save metadata, such as 
collection localities, sample numbers, processing dates, and the names of investigators.  

Table 1 lists the available file headers. The order of the headers, and data columns, does not matter. 
Unrecognized headers and columns are ignored, and are not saved internally. Lines beginning with a 
double slash, ‘//’, are treated as comments. All initial comment lines, before the header line, are treated 

4



EllipseFit User Manual

as metadata and can be edited and will be saved by EllipseFit. Any additional comment lines, after the 
header or lines of data, will be ignored and will not be preserved if the input file is subsequently saved. 

Field Alt Calc Definition

ID N Unique integer id for measurement (added if not input).

X X coordinate of point or ellipse center.

Y Y coordinate of point or ellipse center.

Max A Maximum radius of ellipse or ellipsoid.

Int B Intermediate radius of ellipsoid.

Min C Minimum radius of ellipse or ellipsoid.

Area √ Area of ellipse = ACπ

R Ellipse ratio = A/C (calculated if Max and Min are input).

Phi ϕ Orientation of ellipse long axis clockwise from X axis.

Strike Strike of section ellipse for three-dimensional analysis.

Dip Dip of section ellipse for three-dimensional analysis.

R Calc Calculated R from ellipsoid section.

Phi Calc Calculated ϕ from ellipsoid section.

R Res √ Residual between calculated R and input ellipsoid section R.

Phi Res √ Residual between calculated ϕ and input ellipsoid section ϕ.

X11, Y11 First endpoint of first line of pair.

X12, Y12 Second endpoint of first line of pair.

Alpha1 √ Directed angle of first line clockwise from X axis.

X21, Y21 First endpoint of second line of pair.

X22, Y22 Second endpoint of second line of pair.

Alpha2 √ Directed angle of second line clockwise from X axis.

Beta √ Directed angle between two lines of pair.

Li Initial line length.

Lf Final line length.

Alpha Final measured angle of line defined by Li and Lf.

Stretch Length of line.

Table 1 Spreadsheet field headers used in EllipseFit. Alt indicates alternate input headers. Calc 
indicates columns that are calculated from other parameters, and output to files, but need not be input.

The required input parameters depend on the desired analysis, for example a basic Fry analysis (Section
3.1) requires only [X, Y], however a normalized Fry analysis (Section 3.2) requires [X, Y, R, Phi] or 
[X, Y, Min, Max, Phi] parameters to be specified. Typical two-dimensional ellipse calculations also 
require [X, Y, R, Phi] or [X, Y, Min, Max, Phi] parameters, while three-dimensional ellipsoid 
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calculations require section data to be input as [Max, Int, Min, Strike, Dip] (Chapter 6). Section 2.1.2 
gives example data files for various calculations. 

2.1.2 Example Data Files

The included example files and images can be used to determine input data formats. The following are 
example files for particle ellipse data, for Fry-type or mean ellipse calculations:

E2 - Ramsay and Huber 1983 (small).csv
E2 - Ramsay and Huber 1983 (small).jpg
E2 - Ramsay and Huber 1983 (large).jpg

These give an example of data digitized from a thin section photomicrograph (from Ramsay and Huber,
1983). The [X, Y] coordinates can be used for Fry-type analyses, or the [X, Y, A, B, R, Phi] data for 
normalized Fry or mean ellipse analysis. Note that there are small and large versions, the large version, 
which does not include a data file, may be used for teaching purposes. 

For three-dimensional strain plots, the file:

E3 - Hossack 1968.csv

contains example ellipsoid data (from Hossack, 1968) with [Max, Int, Min] axes data to demonstrate 
Flinn and Hsü-Nadai plots.

Data required for ellipsoid calculation from ellipse section data is given in the file:

ES - Owens 1984.csv

This contains example ellipse section data (fron Owens, 1984 ) for calculating a strain ellipsoid from 
three or more faces using Shan's (2008) method. The strikes and dips of each section must be included, 
so the particle data must include [Max, Min, Phi, Strike, Dip]. 

For analytical Wellman analysis (Vollmer, 2011) from line angular shear data, the files:

LA - Ragan 1985 F10.1a.csv
LA - Ragan 1985 F10.1a.png

contain example line angular shear data and an image (from Ragan, 1985). Each data point requires the 
endpoints of two lines, [X11, X12, X21, X22], that originally had a constant angle. This is an analytical
solution to the classic multiple brachiopod problem illustrated in a number of structural geology texts.

For strain analysis using line stretch data, the file: 

LS - Ragan 2009 T14.9.csv

contains example line stretch data for lines with known initial and final lengths, such as boudins and 
folds. EllipseFit does not currently provide digitizing of this type of data (contact the author if this is of 
interest). In this example, the data is from fold flattening index example (Ragan, 2009), which is 
mathematically related.

Finally, the file:

MLLF Test 60.csv
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is a sample of 60 points used to test the maximum mean log likelihood function (MLLF) method of 
Shan and Xiao (2011). 

2.1.3 Crystal Size Distribution Files

The analysis of primary igneous fabrics can shed light on igneous solidification processes, but is 
complicated by the fact that section data includes cross sections through crystals of different forms. The
topic has an extensive literature that is beyond the scope of this document, see Marsh (1988), Cashman 
and Marsh (1988), and Higgens (2000) for explanations of the theory and collection methodology for 
crystal size distribution (CSD) data.

EllipseFit does not attempt to duplicate the functions of existing CSD software, but offers a workflow 
that can improve the speed of data collection. A typical workflow is to open an image in Photoshop or 
other image processing software, outline the particles, save the outlines as a new image, import the new
image into ImageJ, calculate the particle ellipses, and export the results using a macro to a file that can 
be opened in CSDCorrections (Higgens, 2017). 

Using EllipseFit to digitize the particle ellipses gives a simpler workflow, in that the particle outlines 
can be directly traced as polygons (Section 2.2.5), and the resulting moment-equivalent ellipses output 
in a csd file compatible with CSDCorrections software using the Export CSD command. This workflow
has been successfully used by Dr. K. Patwardhan in the SUNY New Paltz Igneous Petrology 
Laboratory, and continues to undergo refinement. Any additional input is appreciated. 

2.2 Digitizing
Digitizing data from images is a critical, and tedious, aspect of fabric and strain analysis. While there 
are numerous suggested techniques for automatic and semi-automatic extraction of fabric parameters 
from images, it is generally recognized that in most cases a trained human eye is required to reliably 
digitize particle shapes. Image software including Photoshop, Illustrator, GIMP, and Inkscape are often 
used to outline particles by hand. The resulting images of particle outlines can then be imported to 
image analysis software, such as ImageJ or MATLAB to calculate equivalent ellipses, which are then 
used for fabric analysis. EllipseFit offers a simpler workflow, in that images can be opened, processed, 
digitized, and analyzed in one program. Additionally the algorithm used offers potential sub-pixel 
accuracy not normally available in image analysis software.  

2.2.1 Coordinate System

In many, or most, cases it is satisfactory to digitize using the default coordinates, which are in pixels 
with the X axis to the right, and the Y axis down. Most fabric analysis methods do not use absolute 
sizes or areas, so are scale independent. If necessary, pixel data can be converted to absolute units at a 
later date provided the image and a scale are preserved. However, if necessary, absolute scaling can be 
done by one of two methods. 

The easiest method is to select the units in the Preferences Dialog Digitize Pane, and then enter the 
scaling factor in pixels per inch or pixels per centimeter. Note that this is not the same as the image dpi 
(dots per inch) as reported in Photoshop or GIMP, which have no knowledge of the actual image scale. 
The scale needs to be calculated using an object of known physical size, such as a photographed scale 
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bar or coin. This can be done using the mouse coordinates in pixels at both sides of an object of known 
dimensions. 

A second method is to use a Window, with the known width and height of the image. If required, this 
can additionally include the X, Y coordinate of the image origin. Select Preserve aspect if the vertical 
and horizontal scales are equal, as is normally the case.

Although not recommended, it is also possible to switch coordinate systems so that the Y axis is up, or 
the X axis is to the left. Finally, it is possible to set the pitch of the X axis. Normally, the X axis should 
be horizontal for three-dimensional analysis. However, it is possible to set the pitch of the X axis, its 
positive inclination from horizontal. Note that making such corrections is an easy way to make user 
errors in the calculations, so using conventional coordinates and keeping samples and images properly 
oriented is highly recommended. See Section 6.2 for additional information on coordinates for three-
dimensional fabric analysis.

2.2.2 Points

Digitizing particle centers is the most rapid method of data collection, although it limits the possible 
analyses. Select Image > Center Point from the menu or toolbar, and sequentially select particle 
centers. This type of data entry allows various Fry-type analyses (Section 3.1), but not normalized Fry 
or mean ellipse calculations. Also, if the Fry analysis is to be used for irregular polygons (McNaught, 
1994), digitizing as described in Section 2.2.5 or 2.2.6 is required.

2.2.3 Lines

Digitizing line pairs is used for the Wellman method of strain analysis (Section 4.1), where each 
particle, typically a fossil, has two identifiable lines that originally had a known angle between them 
that was subsequently modified by deformation. In this case select Image > Line Pair and sequentially 
digitize each line pair in sequence. See Section 4.1 for an example analysis.

2.2.4 Ellipses

This method provides rapid input of particles that closely approximate ellipses, such as ooids. However
it is not generally recommended for most particles, as the polygon and filled polygon methods are more
widely applicable. The Image > Ellipse command allows five points to be digitized on the perimeter of 
a particle, which are then fit to an ellipse. Particles with more irregular outlines should be digitized 
with either of the two polygon methods (Section 2.2.5 or 2.2.6).

2.2.5 Polygons

The Image > Polygon command provides the best method for digitizing most particles. A particle is 
approximated by a polygon using as many points as necessary, and closed by clicking on the first point.
The polygon is converted to an ellipse that has equivalent first and second moments, referred to here as 
a moment-equivalent ellipse, this includes area, center of mass, and inertia. These are calculated 
mathematically from the digitized polygons, and can be sub-pixel accurate, providing an advantage 
over pixel based methods (Section 2.2.6). 
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Samples of moment-equivalent ellipses can be shown mathematically to give equivalent results as 
elliptical particles, allowing irregular polygons to be used in place of ellipses. Additionally, as 
discussed in Section 3.2, this method extends the Fry method to irregular polygons. Note that this 
technique for calculating ellipses is not a least-squares best fit (e.g., Erslev and Gee, 1990), which is 
likely to give inaccurate results (McNaught, 1994; Mulchrone and Choudhury, 2004).

2.2.6 Filled Polygons

The Image > Filled Polygon command gives similar results as the Image > Polygon command, but 
differs in the method of calculation, using pixel summation for calculation of the moments. In this case 
an image of particle outlines is required, normally black outlines on a white background. Clicking 
inside the outline uses a seed fill algorithm to count pixels and calculate an ellipse with equivalent first 
and second moments, similar to procedures used in ImageJ and MATLAB. This is also an excellent 
method for digitizing particles, but requires the additional step of outlining particles in an image editing
program such as Photoshop or GIMP. 
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3. Point Distribution Analysis
This chapter discusses point distribution methods. It is common in nature for objects to be distributed 
randomly, or uniformly, but with a minimum cutoff distance between them. A random distribution in 
space follows a Poisson distribution (e.g., Davis, 1986), which can be imagined by throwing pingpong 
balls into an empty room. However, in this example the centers of the pingpong balls can never touch. 
If the room is filled with balls, no object center can be closer to another object center than twice the 
radius of a balls, giving a cutoff distance of twice the radius.

The basic idea for methods utilizing point distributions (e.g., Ramsay and Huber, 1983) is that the 
minimum distance between the initial object centers is the same in all directions, thus defining a circle 
in two dimensions or a sphere in three dimensions. After deformation the particle centers are closer in 
some directions and further in others, and the post-strain point distribution defines an ellipse or 
ellipsoid. 

Examples of this type of data include the centers of clasts in sedimentary rocks such as sandstones and 
conglomerates. The centers of phenocrysts in igneous rocks, where nucleation of crystals is prevented 
in proximity to existing crystals due to the chemical gradient, is another example. Two dimensional 
examples include the centers of skolithos burrows and dewatering structures.

If the viscosity of the particles is identical to the viscosity of the enclosing matrix, point distribution 
methods should give similar results to mean ellipse methods discussed in Chapter 5. If the particles 
have a different viscosity, or are even perfectly rigid, it is possible to get an estimate of the strain of the 
rock independently of the particle shape. It may be useful, then, to compare the results of both point 
distribution and ellipse fitting methods. 

Two general point distribution methods have been proposed, a nearest neighbors approach (Ramsay, 
1967; Ramsay and Huber, 1983), and an all object separation approach (Fry, 1979), commonly referred
to as the Fry method. The latter, initially graphical, approach has many variations, one of the most 
common is the normalized Fry method (Erslev, 1988; Erslev and Ge, 1990). It is important to note that 
the normalized Fry method requires the particle shape, and therefore loses complete independence from
mean ellipse methods. 

The nearest neighbors approach (Section 3.3.2) has been enabled computationally by the availability of 
Delaunay triangulation algorithms (e.g., Preparata and Shamos, 1985). This approach was initially 
explored in EllipseFit 1 (Vollmer, 1989), and has since been developed by Mulchrone (Mulchrone, 
2003;  Mulchrone, 2013). EllipseFit uses Delaunay nearest neighbors as an option, which may be used 
to reduce the number of points considered for analysis (Section 3.3.2).

A problem in point distribution analysis is to determine the strain ellipse from the central void. The 
enhanced normalized Fry method (Erslev and Ge, 1990) was developed to solve this, but requires the 
particle ellipses, blurring the distinction between point and ellipse methods. A number of solutions to 
the void fitting problem have been proposed, Section 3.3 discuss some of these methods with additional
variations.

10
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3.1 Fry Analysis
Fry analysis (Fry, 1979) is an important and widely used technique for analyzing point distribution 
data, and there is an extensive literature on it and its variations (e.g., Hanna and Fry, 1979; Crespi, 
1986; Onasch, 1986; Erslev, 1988; Erslev and Ge, 1990; Dunne, Onasch, and Williams, 1990; 
McNaught, 1994; McNaught, 2002; Shan and Xiao, 2011; Waldron and Wallace, 2011; Mulchrone, 
2013).

A Fry analysis can be simply done with two pieces of tracing paper, by tracing all of the particle centers
on one sheet, then drawing a center point on a second sheet overlain on the first, and then sequentially 
moving the center point to each point and trace each point. For n initial points, this generates: 

nf = n! / (2 * (n - 2)!)

points, which is a lot of points to draw by hand, as former students will attest. To illustrate the use of 
the method in EllipseFit, start EllipseFit and open the image file (File > Open Image):

E2 - Ramsay and Huber 1983 (large).jpg

This is a photograph of a deformed ironstone oolith in thin section from Ramsay and Huber (1983) that 
is widely used as a test image for strain analysis. For point digitizing select Digitize > Center Point, and
Digitize > Add Tool, as indicated by the toolbar icons in Figures 1 and 2. 

Use the Zoom In and Zoom Out tools to enlarge the image, and click on one particle center. The Data 
Window will display a highlighted line of data. Before continuing, open the Fry plot (Analyze > Fry 
Plot), as shown in Figure 2. 

11

Figure 1. EllipseFit's Image Window used for digitizing, with 
photomicrograph of a deformed oolite from Ramsay and Huber 
(1983). 
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Continue digitizing point centers, ideally working out from one point digitizing adjacent points and 
keeping a roughly circular area. The Fry plot will start to develop, with each new set of generated 
points highlighted (Figure 3). 

Use the Hand Tool (Digitize > Hand Tool) to scroll, and the Zoom Tool to zoom (Digitize > Zoom). The 
Command (Mac) or Control (Windows and Linux) + and – keys are used to zoom in and out. Holding 
down the Shift key allows scrolling with the mouse. Points can be deleted by using the Find Tool 
(Digitize > Find Tool) to highlight a point, and delete it using the Cut command (Edit > Cut). A point can
also be deleted by selecting it in the Data Window and deleting it there. It is important to be objective, 
and it may be best to digitize all available points, however note that some particles may not meet the 
required assumptions. Also, note that the centers of the particles in two-dimensions do not generally 
correspond to their three-dimensional centers, as they lie on an arbitrary plane cutting through the rock,
so the assumption of of a uniform cutoff distance is weakened, this is further discussed in Section 3.2. 

It is also desirable to select approximately equal numbers of particles in all directions, so the point 
density is not biased by direction. This is one reason to maintain a uniform point density in a circular 
area while digitizing, and why having the interactive Fry plot open can assist in particle selection, this 
is discussed further in Section 2.2.2. 

12

Figure 2. EllipseFit's Image Window, Data Window and Fry Graph displaying a single data 
point.
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To change the size of the digitized points, click the Preferences icon to open the Preferences Dialog,  
where most of the EllipseFit preferences can be changed. Note that some panes have multiple pages, 
use the Symbols and Settings buttons to toggle through them. The effect of preference changes can be 
previewed with the Preview button before committing to them with the OK button.

13

Figure 3. Fry plot after digitizing 20 adjacent particle centers. The generated points are 
highlighted. On the right, note the presence of the spurious data point (each point is mirrored 
about the center) generated by clicking too close to an existing point, i.e. an operator error which 
can be deleted.  

Figure 4. The EllipseFit Preferences dialog where 
most preferences are set. The Symbols button 
displays an additional page. Make sure Void fit 
options is deselected during digitizing.
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To view the data as a Strain Map select Analyze > Strain Map. This displays the data as particle centers,
this population can be strained and unstrained as described in Chapter 7. 

Figure 5 is the plot after carefully selecting 60 particle centers, a probable minimum number for 
analysis (Shan and Xiao, 2011), and after digitizing 252 points, essentially all of them.

To zoom in for a better image of the central void, open the Preferences Dialog, uncheck Auto-scale, 
and enter a number smaller than the displayed Data radius (Figure 6). 

14

Figure 5. Fry plots after digitizing 60 carefully selected points, and after digitizing 252 points, 
essentially all of them. These images are saved from EllipseFit.

Figure 6. Set the plot radius to display the central 
void by unchecking Auto-scale, and entering a 
smaller plot radius.
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Figure 7 shows the zoomed in central voids for the two examples. The next step is to determine the 
best-fit ellipse for the central void displayed in Figure 7. This can be a subjective process, and 
objectively choosing this ellipse is the subject of a number of papers (e.g., Erslev, 1988; Erslev and Ge,
1990; Shan and Xiao, 2011; Waldron and Wallace, 2011; Mulchrone, 2013). 

The enhanced normalized Fry method (Erslev, 1988; Erslev and Ge, 1990) is one that is commonly 
employed, but requires the digitized ellipses of each particle. The normalized Fry method is the subject 
of Section 3.2. Ideally a method should require only the point data (e.g., Shan and Xiao, 2011; Waldron
and Wallace, 2011; Mulchrone, 2013). EllipseFit implements a number of algorithms with variations as
discussed in Section 3.3.

For the purposes of this section, it will be assumed that the void has been defined well enough to pick 
out the void by eye, which can be a good enough estimate, and also makes a good exercise for student 
laboratories. Click on the Centered Ellipse icon (Digitize > Centered Ellipse), and click at the edge of 
the void. An orange circle marks the starting point, subsequent points are marked by a yellow circle. 
When finished, click on the orange circle and the ellipse will be calculated and displayed in the Log 
Window.  

15

Figure 7. Close up of the central voids for the two data examples of 60 and 252 points.
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For this sample, the calculated results are reported by EllipseFit as:

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-05 11:15:45
==============================
N : 60
Pairs : 1770
Time : 00:00:00
Digitized
  Normalized : False
  Delaunay   : False
Best-Fit Ellipse  
  n   = 17
  R   = 1.758
  ϕ   = 25.45°
  RMS = 0.0583 

A centered ellipse was calculated from the 17 digitized points. The calculation is rotationally invariant, 
and the best fit found by minimizing the sum of the squares of the distance of the points from the 
ellipse, i.e., the residuals. The minimization is solved from the linear equations using a LU 
decomposition. 

The RMS value is the root mean square measure of the variation of the residuals from the ellipse, that 
is the square root of the sum of the squares of the residuals of the data from the fitted ellipse. RMS is a 
common way to express goodness of fit of least squares solutions. It is not a measure of the error in the 
strain calculation, and is not technically an error. It is, however, a measure of how closely the digitized 
points fit the ellipse. A small RMS means that the entered points lie close to an ellipse. It makes a good 
class exercise for students to solve and compare their results and RMS.

16

Figure 8. Digitizing the central void. The orange point is the start point, the yellow are subsequent
points. Click on the orange point when finished, and the ellipse is calculated. The point size is set 
larger than the default size for the illustration.
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As a final step in this analysis, select the Edit > Transform Image command and enter the results into 
the dialog as in Figure 9. The image will be unstrained to remove the calculated strain as shown in 
Figure 10.

17

Figure 9. The Transform Image dialog with 
values entered to unstrain the mage.
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18

Figure 10. The oolith photomicrograph after being unstrained using EllipseFit's Image Transform 
command.
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Next select the Analyze > Transform Data command and enter the calculated values as shown in Figure
11. Press Transform and then Accept.

The data is unstrained using the calculated values, as shown by the Fry plot in Figure 12. The Rectify 
option resolves the offsets caused by the image transformation, so the data points remain centered over 
the particle centers. 

19

Figure 12. Fry plot of the unstrained 60 point 
data after using the Transform Data command to
unstrain (retrodeform) the data using the 
calculated values.

Figure 11. The Transform Data dialog with 
values entered to unstrain (retrodeform) the data.
Set Mean is only used with ellipse data. Rectify 
resolves the offsets caused by the image 
transformation.
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3.2 Normalization
As discussed in Section 3.1, the Fry analysis is a two-dimensional solution to a three-dimensional 
problem, since initial particles are assumed circular instead of spherical. Even if the particles have a 
uniform size, a section through a sample will show them as different size particles. One solution 
developed to overcome this is the normalized Fry analysis (Erslev, 1988; Erslev and Ge, 1990; 
McNaught, 1994, 2002).

The distances between particles are normalized to account for the difference in the sizes of the 
particles, which can greatly improve the sharpness of the central void. However, the ellipse sizes and 
orientations are required for this, so the particle ellipses must be digitized, as discussed in Chapters
2.2.4, 2.2.5, and 2.2.6. For an example of this analysis, open the image file:

E2 - Ramsay and Huber 1983 (small).jpg

and the data file:

E2 - Ramsay and Huber 1983 (small) 

This is the 252 point data set used in Section 3.1. 

The data is overlain on the image, and, if the Find Tool icon is selected, you can select individual 
particles that are highlighted in the Data Window and the Fry Plot. This selection method is 
implemented for most of the plots discussed in subsequent chapters. The Fry plot will look like Figure
5B.

20
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To zoom in on the central void, open the Preferences Dialog, deselect Auto-scale, and enter 50 for the 
Graph radius as shown in Figure 14.  

21

Figure 14. Settings to display the central void 
without normalizing.

Figure 13. EllipseFit Image window with ellipse data overlain. Selecting the Find Tool allows 
interactive selection of particles that are highlighted in the Data window as well as on data plots 
including the Fry plot.  
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The unnormalized plot is displayed in Figure 15.

To normalize the plot select Normalize, as shown in Figure 16. Note that the Normalized radius is now 
used due to the normalization to a unit circle, the default value is 1.5 as shown. The resulting 
normalized plot is shown in Figure 17. Note the clear sharpening of the central void.

22

Figure 15. The Fry plot without normalizing, 
using the settings displayed in Figure 14.

Figure 16. Settings to display a normalized Fry plot. 
Note that the Normalized radius is now used due to
the normalization to a unit circle. 



EllipseFit User Manual

Normalizing the plot can be done for the enhanced normalized, exponential edge detection, Delaunay 
neighbors, and density gradient methods described in the next section, providing object shapes (R, ϕ) 
are available.

McNaught (1994) suggested a method for modifying the normalized Fry method for aggregates of non-
elliptical grains. Rather than fitting least-squares ellipses to the particle outlines (polygons) and using 
the ellipse centers for Fry analysis, he calculated the center of mass (centroid) and area of the polygons 
to construct the normalized Fry plot. The ellipse digitizing method recommended here, using calculated
polygon moment-equivalent ellipses (Steger, 1996), is more complex, giving second moments, from 
which an ellipse orientation and axial ratio can be calculated, but also gives the polygon centroid and 
area. The construction of normalized Fry plots uses only the centroid and area, so the resulting Fry 
plots will be identical to those constructed using McNaught's method. 

3.3 Objective Void Fitting
Calculating the strain from a sample of points should ideally be objective, not requiring a user to 
subjectively determine the best-fit ellipse, and, ideally should not require additional information about 
particle shape. An objective numerical calculation is therefore desirable, and a number of methods have
been proposed (McNaught, 1994;  Mulchrone, 2003, 2013; Waldron and Wallace, 2007; Lisle, 2010; 
Shan and Xiao, 2011; Reddy and Srivastava, 2012; Kumar et al., 2014). Methods currently 
implemented in EllipseFit, and described in this chapter, are accessed using the Fit Void command and 
then selected from the Fit Void dialog.

Kumar et al. (2014) tested six such methods, including the Delaunay triangulation nearest neighbors 
(DTNN), density contrast (point-count), exponential edge detection (EED, renamed here from 
continuous function, with consent of J. Waldron), and mean log likelihood methods, using two-
dimensional simulated data sets, and concluded that of those six, exponential edge detection (Waldron 
and Wallace, 2007) is the most accurate, followed by the DTNN method (Mulchrone, 2013).

23

Figure 17. Plot of the normalized data. Note the 
better resolution of the central void.
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The enhanced normalized (Erslev and Ge, 1990) and related Delaunay nearest neighbors (Mulchrone, 
2003) methods require particle shape information, [ai, bi, ϕi], ellipse radii and orientations, they differ in
that the enhanced method uses the entire point cloud, that is, all object to object distances, while 
Delaunay methods use only the nearest neighbors distances (e.g., Ramsay and Huber, 1983). 

The exponential edge detection, density contrast, and mean log likelihood methods do not require shape
information. This gives them an advantage in terms of the speed of data collection, and where shape 
information is not available, such as in the spacing of dewatering pipes (Waldron and Wallace, 2007). 
Additionally, the analysis is entirely independent of particle shape, so may be used to complement 
ellipse based methods. 

Kumar et al. (2014) concluded that the exponential edge detection (EED) method was better than the 
density contrast method, and that the DTNN, density contrast, exponential edge detection, and image 
analysis methods are least affected by the degree of sorting, the nature of distortion or the amount of 
distortion. The mean log likelihood method (Shan and Xiao, 2011), gave less accurate results, possibly 
because the non-random point distribution in their simulated samples violated the method’s 
requirement of a homogeneous truncated Poisson distribution. 

Void fitting methods that are not computationally intensive are suitable for bootstrap error analysis and 
calculation of confidence intervals. See Section 3.3.7 for a discussion of error analysis and the 
bootstrap methodology, and Section 3.3.8 for a relative comparison of the methods.

3.3.1 Enhanced

The enhanced and enhanced normalized Fry methods (Erslev, 1988; Erslev and Ge, 1990) use a user 
specified cutoff radius to exclude particles beyond the a certain distance from the void center. This is 
set by a user defined value, the selection factor, sf, which has a default value of sf = 1.2. In the Void Fit
dialog select options as in Figure 18, press Preview, and then Run. EllipseFit calculates the best-fit 
ellipse through the cloud of points using a rotationally invariant least squares method. 

24
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The results from the Log window are:

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 12:33:01
==============================
N     : 252
Pairs : 31626
Time  : 00:00:00
Enhanced
  Normalized       : False
  Delaunay         : False
  Selection factor : 1.200
  Enhanced pairs   : 306
Best-Fit Ellipse
  n   = 306
  a   = 35.023
  b   = 21.071
  R   = 1.662
  ϕ   = 25.83°
  RMS = 0.2889

                      
RMS (root mean square) is a measure of the deviations of the residuals, and can be used to refine the 
selection factor. However, note that smaller number of points will generally have a smaller RMS. For 
example, three points give RMS = 0, so finding the minimum RMS is not a valid strategy.

25

Figure 18. Settings to display an enhanced plot.

Figure 19. Fry plot with ellipse fitted to the 
enhanced points.
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Selecting Normalize gives the following results and plot (Figure 20). 

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 12:41:08
==============================
N     : 252
Pairs : 31626
Time  : 00:00:00
Enhanced
  Normalized       : True
  Delaunay         : False
  Selection factor : 1.200
  Enhanced pairs   : 306
Best-Fit Ellipse
  n   = 306 pairs
  a   = 0.919
  b   = 0.566
  R   = 1.622
  ϕ   = 24.43°
  RMS = 0.1582     

The selection factor (sf) is a user defined parameter that controls how many of the points are to be 
included in the selection. The value should be a small number greater than 1, the default is 1.2. 
Mulchrone (2002) studied the effect of the sf on error minimization, and concluded that errors were 
minimized using sf between about 1.1 and 1.3. 

Select the Bootstrap option to do an error analysis by resampling the data set with replacement to 
create resamples (Section 3.3.7). The following are example results from an enhanced plot bootstrap 

26

Figure 20. Fry plot with ellipse fitted to the 
enhanced normalized points.
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error analysis. Figure 21 is a plot of the resample means used to determine the confidence intervals. 
Note that, due to the random sampling, the error estimates will vary a small amount for each run. 

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 14:39:40
==============================
N     : 252
Pairs : 31626
Time  : 00:00:21
Enhanced
  Normalized       : False
  Delaunay         : False
  Selection factor : 1.200
  Enhanced pairs   : 306
Best-Fit Ellipse
  n   = 306 pairs
  a   = 35.023
  b   = 21.071
  R   = 1.662
  ϕ   = 25.83°
  RMS = 0.2889
Bootstrap Confidence
  n     = 1000 resamples
  R     = 1.662
  ϕ     = 25.83°
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Figure 21. Elliott polar plot of the means of 
1000 bootstrapped resamples used for the 
confidence intervals using the enhanced 
method. The resample means are rotated to 
the sample mean, the red circle is the mean 
of the resample means (Section 3.3.7).

Figure 22. Cartesian Rf / ϕ plot of the 
means of 1000 bootstrapped resamples used
for the confidence intervals using the 
enhanced method. The resample means are 
rotated to the mean, the red circle is the 
mean of the resample means. Due to 
distortion inherent in Rf / ϕ  plots, the 
position of the mean on the ϕ axis has little 
significance.  
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  R 95% = 0.134
  ϕ 95% = 3.34°

The bootstrap resample means for an enhanced normalized analysis are shown in Figure 23, and the 
output is:

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 17:24:09
==============================
N     : 252
Pairs : 31626
Time  : 00:00:26
Enhanced
  Normalized       : True
  Delaunay         : False
  Selection factor : 1.200
  Enhanced pairs   : 306
Best-Fit Ellipse
  n   = 306 pairs
  a   = 0.919
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Figure 23. Elliott polar plot of the means of 
1000 bootstrapped resamples used for the 
confidence intervals using the enhanced 
normalized method. The resample means 
are rotated to the sample mean, the red 
circle is the mean of the resample means 
(Section 3.3.7). Note the tighter clustering 
over Figure 21, indicating higher 
confidence in the mean.

Figure 24. Cartesian Rf / ϕ plot of the 
means of 1000 bootstrapped resamples used
for the confidence intervals using the 
enhanced normalized method. The 
resample means are rotated to the sample 
mean, the red circle is the mean of the 
resample means. Due to distortion inherent 
in Rf / ϕ  plots, the position of the mean on 
the ϕ axis has little significance.
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  b   = 0.566
  R   = 1.622
  ϕ   = 24.43°
  RMS = 0.1582
Bootstrap Confidence
  n     = 1000 resamples
  R     = 1.622
  ϕ     = 24.43°
  R 95% = 0.078
  ϕ 95% = 1.84°     

                   

This gives results close to the enhanced analysis, [R, ϕ]  = [1.622, 24.43°] versus [1.662, 25.83°], with 
a smaller confidence intervals. Figure 23 shows the tighter clustering reflected by the smaller 
confidence intervals.

An additional option to aid in evaluating the effect of the value of sf is given by the Iterate and Log 
options. If selected, the value of sf is iterated by an increment, and the associated mean and confidence 
calculated. By default, the iteration steps through values from 1.1 to 1.3 by an increment of 0.1. The 
output for an enhanced normalized analysis gives:

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 18:37:15
==============================
N     : 252
Pairs : 31626
Time  : 00:00:00
Enhanced
  Normalized       : True
  Delaunay         : False
  Selection factor : 1.200
Iterated Ellipses
  sf      R       ϕ        Pairs
  1.1000  1.6064  24.668°  218
  1.1100  1.6064  24.402°  230
  1.1200  1.6044  24.152°  239
  1.1300  1.5958  24.217°  251
  1.1400  1.5962  24.418°  258
  1.1500  1.5995  24.338°  265
  1.1600  1.6079  24.533°  277
  1.1700  1.6182  24.467°  283
  1.1800  1.6124  24.054°  291
  1.1900  1.6130  24.235°  298
  1.2000  1.6224  24.431°  306
  1.2100  1.6316  24.755°  314
  1.2200  1.6474  24.765°  323
  1.2300  1.6411  25.093°  336
  1.2400  1.6433  25.394°  341
  1.2500  1.6441  25.395°  352
  1.2600  1.6492  25.489°  359
  1.2700  1.6659  25.367°  368
  1.2800  1.6698  25.770°  375
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  1.2900  1.6790  25.719°  381
  1.3000  1.6765  26.220°  391
Mean of Iterated Ellipses
  n     = 21 ellipses
  R     = 1.677
  ϕ     = 26.22°
  R 95% = 0.012
  ϕ 95% = 0.37°   

3.3.2 Delaunay Neighbors

A Fry plot contains information about the distances between all data points. An alternate methodology 
is to use only the nearest neighbors (Ramsay, 1967; Ramsay and Huber, 1983; Mulchrone, 2002, 
2013). A Delaunay triangulation is a triangulation of points in a plane such that no point is inside the 
circumcircle of any triangle, the edges of the triangles therefore define the nearest neighbor distances 
(Figure 25). There can be edge effects related to the shape of the sampled area, discarding the bounding
hull helps to minimize this. Additionally, particularly at higher strains, the nearest neighbors are not 
guaranteed to be the same as the nearest neighbors prior to deformation. However, this subset of points 
can provide a less numerically intensive set for function or search minimization procedures. 

In EllipseFit the use of Delaunay nearest neighbors is an option in the enhanced, exponential edge 
detection, density contrast, and weighted least-squares methods. In each case the point cloud is reduced
to the nearest neighbors using the edges of a Delaunay triangulation, reducing the number of required 
calculations in a search or minimization. The method described in this section is the enhanced 
normalized Delaunay method, which closely follows the Delaunay triangulation nearest neighbors 
(DTNN) method of Mulchrone (2003).

30

Figure 25. Strain map with Delaunay triangulation excluding the
bounding hull. The triangle edges are the nearest neighbor 
distances.
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Figure 26 shows the Void Fit dialog Enhanced normalized pane with the settings to display Delaunay 
neighbors. The resulting plot is shown in Figure 27. Note the presence of the horizontal and vertical 
point “wings” due the rectangular shape of the digitized area.

Figures 28 and 29 are plots using the enhanced Delaunay, and the enhanced normalized Delaunay 
options using the default selection factor (sf) of 1.2. The results of the enhanced normalized Delaunay 
method are:
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Figure 26. Enhance normalized settings pane 
with the Delaunay option selected.

Figure 27. Fry plot showing Delaunay 
nearest neighbor points. The vertical and 
horizontal “wings” are due to the 
rectangular shape of the digitized area.
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Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 18:47:39
==============================
N     : 252
Pairs : 717
Time  : 00:00:00
Enhanced
  Normalized       : True
  Delaunay         : True
  Selection factor : 1.200
  Enhanced pairs   : 305
Best-Fit Ellipse
  n   = 305 pairs
  a   = 0.918
  b   = 0.566
  R   = 1.621
  ϕ   = 24.45°
  RMS = 0.1584       

Comparing the results to the enhanced normalized method, the Delaunay neighbors option has used 
one less point pair, 305 as opposed to 306, and the results are nearly identical, [R, ϕ] = [1.621, 24.45°] 
as opposed to [1.622, 24.43°]. Figure 30 shows the means of 1000 bootstrap resamples used to 
determine confidence intervals for the enhanced normalized Delaunay method. Using the Bootstrap 
option to calculate confidence gives:
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Figure 28. Fry plot showing the results of 
the enhanced Delaunay method.

Figure 29. Fry plot showing the results of 
the enhanced normalized Delaunay method.
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Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 18:53:37
==============================
N     : 252
Pairs : 717
Time  : 00:00:00
Enhanced
  Normalized       : True
  Delaunay         : True
  Selection factor : 1.200
  Enhanced pairs   : 305
Best-Fit Ellipse
  n   = 305 pairs
  a   = 0.918
  b   = 0.566
  R   = 1.621
  ϕ   = 24.45°
  RMS = 0.1584
Mean and Bootstrap Confidence
  n     = 1000 resamples
  R     = 1.621
  ϕ     = 24.45°
  R 95% = 0.621
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Figure 30. Polar plot of the means of 1000 
bootstrapped resamples used for the 
confidence intervals using the enhanced 
normalized Delaunay method. The replicate
means are rotated to the sample mean, the 
red circle is the mean of the replicate means
(Section 3.3.7). Scatter in the plot reflects 
the lower confidence in the mean.  

Figure 31. Cartesian Rf / ϕ plot of the 
means of 1000 bootstrapped resamples used
for the confidence intervals using the 
enhanced normalized Delaunay method. 
The resample means are rotated to the 
sample mean, the red circle is the mean of 
the resample means. Due to distortion 
inherent in the Rf / ϕ  plot, the position of 
the mean on the ϕ axis has little 
significance.
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  ϕ 95% = 14.75°        

The enhanced normalized Delaunay method bootstrapping is faster that the enhanced normalized, less 
than one second versus 26 seconds on a 3.06 GHz machine, however gives less confidence, [R 95%, ϕ 
95%] = [0.621, 14.75°] versus [0.078, 1.84°] as illustrated in Figures 23, 24, 30, and 31.

As discussed in the previous section, the selection factor (sf) is a user defined parameter that controls 
how many of the points are to be included in the selection. The value should be a small number greater 
than 1, the default is 1.2. The Iterate and Log options can be used to evaluate the effect of sf on the 
analysis, and to select one that minimizes the error. The reduction of the data cloud by using Delaunay 
triangulation can similarly be applied to the density contrast, exponential edge detection, and weighted 
least squares methods. 

3.3.3 Density Contrast

Waldron and Wallace (2007) suggested a point counting method that does not require any information 
about particle shape. This gives an advantage in terms of the speed of data collection, and where shape 
information is not available, such as in their example of the spacing of dewatering pipes. Additionally, 
the analysis is entirely independent of particle shape, so may be used to complement shape-based 
methods. If the object shape parameters R and ϕ are available, however, the plot can be normalized.

The method uses two annular ellipses with the same aspect ratio. The parameters are the minimum 
radius of the inner void fit ellipse, its aspect ratio R, and orientation ϕ, which are varied to minimize the
density contrast, C. The Void Fit Density contrast dialog pane is shown in Figure 32. Options include 
minimum, maximum, and increments of the three search parameters. These can be automatically set to 
suggested values by pressing the Set button, or can be set manually. Figure 35 shows a preview of 
automatically selected density contrast options. The two inner blue rings represent the minimum and 
maximum search values for the minimum (short) void fit ellipse radius. The outer yellow circle is the 
maximum search radius. The default optimized search settings increment R by 0.01 from 1 to 3, ϕ by 
0.1° from 0° to 179.9°, and b (the ellipse short axis) by 100 increments over a selected range. 
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The resulting solution is shown graphically in Figures 34 and 35, and the results, showing the 10 best 
solutions are as follows:

35

Figure 33. Preview of automatic density 
contrast options. The two inner blue circles 
represent the minimum and maximum 
search values for the short axis of the void 
fit ellipse. The outer yellow circle is the 
maximum search radius. 

Figure 32. Void Fit Density contrast settings 
pane after having set the automatic options.
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Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-19 21:34:51
==============================
N     : 252
Pairs : 3985
Time  : 00:00:14
Density contrast
  Normalize        : False
  Delaunay         : False
  Iterations       : 46521
  K                : 1.414
Best-Fit Ellipses
  Max      Min      R      ϕ       C
  25.7329  16.3904  1.570  28.00°  1.691497
  25.8691  16.2699  1.590  28.50°  1.689513
  25.7064  16.2699  1.580  28.50°  1.689057
  25.7064  16.2699  1.580  28.30°  1.683483
  25.5437  16.2699  1.570  29.40°  1.677375
  25.8390  16.1494  1.600  28.00°  1.676166
  25.6775  16.1494  1.590  28.00°  1.675463
  25.6462  16.0289  1.600  28.40°  1.673105
  25.6462  16.0289  1.600  28.00°  1.656090
  25.3086  16.8724  1.500  29.00°  1.654347
Mean of Best-Fit Ellipses
  n     = 10
  R     = 1.578
  ϕ     = 28.40°
  R 95% = 0.022
  ϕ 95% = 0.70°    
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Figure 34. Plot with best-fit ellipse using 
the automatically selected density contrast 
options. The red ellipses define the best-fit 
annulus, both have the same aspect ratio 
and orientation, the inner defines the void 
fit. 

Figure 35. Zoomed in view of Figure 34 
showing the void best-fit ellipse and outer 
annulus ring. The clip radius is 40.
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The solutions are in decreasing order of C, so the best is the first in the list. The default value for search
parameter, K = √2, gives an equal area to the inner ellipse and the search annulus, this was suggested 
by Waldron and Wallace (2007), and affirmed by Kumar et al. (2014).

3.3.4 Exponential Edge Detection

Waldron and Wallace (2007) suggested a second method, exponential edge detection (EED, renamed 
here from continuous function with consent of J. Waldron) that also does not require any information 
about particle shape. Again, this gives an advantage in terms of the speed of data collection, and where 
shape information is not available, such as in their example of the spacing of dewatering pipes. 
Additionally, the analysis is entirely independent of particle shape, so may be used to complement 
ellipse based methods. If the object shape parameters [a i, bi, ϕi] are available, however, the plot can be 
normalized.

The method maximizes an exponential function, Z' = f[a, b, ϕ], that is calculated for all points in the 
search radius. In contrast to the enhanced method, which fits an ellipse through a subset of points near 
the void edge, this procedure locates the ellipse that defines the edge of the void by looking for the 
steepest density gradient. The parameters are the void ellipse long radius, short radius, and orientation. 
An additional user defined parameter, k, is by default set to k = 3, as suggested by Waldron and Wallace
(2007), and affirmed by Kumar et al. (2014). The Exponential edge dialog pane is shown in Figure 36. 
The search can be conducted either by an optimized parameter search, as was done for the density 
contrast method, or more efficiently, by using function minimization (e.g., Press et al., 2007), as used 
in this example.
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The parameters [a, b, ϕ] must be set to initial estimated values. These can be automatically set to 
suggested initial values by pressing the Set button, or can be set manually. Figure 37 is a Fry plot with 
suggested initial parameters automatically selected by pressing the Set button. The resulting solution is 
shown graphically in Figures 38 and 39, and the results are as follows:

38

Figure 36. Exponential edge detection settings 
pane after having set the automatic options.

Figure 37. Preview of automatic 
exponential edge detection options. The 
blue ellipse is the initial estimated solution 
automatically chosen using the Set button. 
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Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-20 10:29:46
==============================
N     : 252
Pairs : 3985
Time  : 00:00:00
Exponential edge detection
  Normalize        : False
  Delaunay         : False
  Minimize         : True
  Iterations       : 204
  k                : 3.000
Best-Fit Ellipses
  Max      Min      R      ϕ       Z'          Z*
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
Mean of Best-Fit Ellipses
  n     = 10 Best-fit ellipses 
  R     = 1.637
  ϕ     = 25.53°
  R 95% = 0.000
  ϕ 95% = 0.00° 
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Figure 38. Plot showing best-fit ellipse 
determined from the automatically selected 
exponential edge detection options. The red
ellipse  defines the best void fit ellipse. 

Figure 39. Zoomed in view of Figure 38 
showing the void best-fit ellipse in red. The 
blue ellipse is the initial estimate. The clip 
radius is 40.
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The minimization procedure converges in less than one second (3.06 GHz iMac) after 204 iterations, 
all of the 10 best solutions are identical at the output precision. The solutions are in decreasing order of 
Z', so the best is the first in the list.

Confidence intervals for [R, ϕ] can be calculated using bootstrapping, as in the enhanced, enhanced 
normalized, and enhanced normalized Delaunay methods. Prior to bootstrapping, it is suggested that 
the minimization be done once, then repeated by entering the solution as the new initial parameters. In 
this example, there is no change in the output values. Then, after refining the solution, select the 
bootstrap option to calculate the confidence intervals. Figure 40 is a polar plot of 1000 resample means 
used for the confidence intervals, and the results are: 

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-20 11:45:49
==============================
N     : 252
Pairs : 3985
Time  : 00:04:46
Exponential edge detection
  Normalize        : False
  Delaunay         : False
  Minimize         : True
  Iterations       : 1000
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Figure 40. Polar plot of the means of 1000 
resamples used to calculate the confidence 
intervals using exponential edge detection. 
The resample means are rotated to the 
sample mean. The red circle is the mean of 
the resample means (Section 3.3.7).

Figure 41. Cartesian Rf / ϕ plot of the 
means of 1000 resamples used to calculate 
the confidence intervals using exponential 
edge detection. The resample means are 
rotated to the sample mean. The red circle 
is the mean of the resample means. Due to 
distortion inherent in the Rf / ϕ  plot, the 
position of the mean on the ϕ axis has little 
significance.
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  k                : 3.000
Best-Fit Ellipses
  Max      Min      R      ϕ       Z'          Z*
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
  26.8921  16.4278  1.637  25.53°  33.205496  1.579820
Bootstrap Confidence
  n     = 1000 Resamples
  R     = 1.637
  ϕ     = 25.53°
  R 95% = 0.165
  ϕ 95% = 4.83°

The bootstrapping process is relatively slow, compared to the enhanced methods bootstrapping, but is 
less than 5 minutes on a 3.06 GHz iMac. For comparison with previous sections, the following are the 
results for a normalized exponential edge detection analysis:

41

Figure 42. Polar plot of the means of 1000 
resamples used to calculate the confidence 
intervals using normalized exponential 
edge detection. The resample means are 
rotated to the sample mean. The red circle 
is the mean of the resample means (Section
3.3.7).

Figure 43. Cartesian Rf / ϕ plot of the 
means of 1000 resamples used to calculate 
the confidence intervals using normalized 
exponential edge detection. The resample 
means are rotated to the sample mean. The 
red circle is the mean of the resample 
means. Due to distortion inherent in the Rf /
ϕ  plot, the position of the mean on the ϕ 
axis has little significance.
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Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-20 15:15:30
==============================
N     : 252
Pairs : 3952
Time  : 00:05:27
Exponential edge detection
  Normalize        : True
  Delaunay         : False
  Minimize         : True
  Iterations       : 1000
  k                : 3.000
Best-Fit Ellipses
  Max      Min      R      ϕ       Z'          Z*
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
  0.7841  0.4506  1.740  24.85°  1.162810  1.956365
Bootstrap Confidence
  n     = 1000 Resamples
  R     = 1.740
  ϕ     = 24.85°
  R 95% = 0.124
  ϕ 95% = 2.71°         

3.3.5 Mean Log Likelihood

Shan and Xiao (2011) suggest a mean log likelihood function (MLLF) method where they examine the 
statistics of a truncated Poisson distribution, and define the MLLF as the average sum of the log 
probability distribution function (PDF) of each individual point in the deformed state. This is related to 
the density distribution around each point.

The PDF in the deformed state is related to the pre-deformation PDF by the shape and orientation of 
the central void, giving as parameters a cutoff distance, the ratio R, and the orientation ϕ. The function 
is complex however, and is solved using a gird search to locate the maximum MLLF. The search is 
over the range ϕ = 0° to 179° in steps of 1°, and R = 1 to 20 in steps of 0.1. Once R and ϕ are 
determined, the sample is retro-deformed, and a 50 step search is done to locate the cutoff radius.

Shan and Xiao (2011) further suggest an approach to improve the results using a cross validation 
technique for detecting spurious points by sequentially removing up to 10 points, and repeating the 
search. These algorithms were implemented by Y. Shan in a Fortran program which was reimplemented
in EllipseFit with careful testing to insure that identical results are obtained.
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The results are the best estimates values of R, ϕ. initial cutoff distance, and a set of neighborhood 
points. This method has advantages in that it is a robust numerical solution, and one that uses all of the 
points to define the central void. A disadvantage of the method is the computing time required to 
calculate the solution. In particular the cross-validation can take several hours. 

To run a test sample open the file MLLF Test 60.csv. This data is the 60 point oolith sample used in 
section 3.1, and was carefully selected to avoid spurious points, and to avoid a directional bias. In the 
Mean log likelihood pane of the Void Fit dialog, leave Cross validate off, and press OK.

The Void Fit dialog displays the progress in its status bar, showing the search iteration passes in 
degrees, and is done at 180. The process should complete in less than a minute, and the results 
displayed in the Log window, and on the Fry Plot (Figure 44).

The results reported in the log file are:

N = 60
MLLF Calculations
–----------------
Pass    Mean LL      R    Phi     Cutoff        Stat    Density
   0   -0.31829   1.90  25.00   86.98953     0.67361    0.84687
MLLF Results
–-----------
Point statistics:
Number                        =         60
Calculated density            =    0.00004
Real density                  =    0.00000

43

Figure 44. Fry plot with results of the mean 
log likelihood function (MLLF) maximization
search. The ellipse is the result of the MLLF 
grid search. The green markers highlight the 
Fry neighbor points.

Figure 45. Fry plot of the results using the 
cross-validation option for mean log 
likelihood maximization.



EllipseFit User Manual

Results:
Mean log-likelihood           =   -0.31829
R, strain ratio               =    1.90000
Phi, angle of max strain axis =   25.00000
Cutoff radius                 =   86.98953

In Figure 44 the ellipse is the result of the MLLF grid search. The green markers highlight the Fry 
neighbor points, those that maximize the MLLF after an intensive grid search. 

To test the cross validation procedure, select the Cross validation option. There are now three iteration 
passes displayed, the first is 0 to 10, where 0 is the first calculation as done above. Passes 1 to 10 are 
the cross validation iterations, 1 to 60 are the data points, and 1 to 180 are the ϕ grid search in degrees. 
The R grid search values (0.1 to 20.0 by default), and the 1 to 50 distance search loops are not 
displayed.

The MLLF search is computationally intensive, especially for cross validation (during some test runs 
the laptop was set on marble coasters to keep it from overheating). After about 6 hours (on a 3.06 GHz 
iMac) the process completed. The search can be canceled at any time, and the results of the completed 
passes will be displayed.

Mean Ellipse Calculations
MLLF Test 60.tsv
2014-05-31 16:30:46
==============================
N = 60
MLLF Calculations
-----------------
Pass    Mean LL      R    Phi     Cutoff       Stat    Density
   0   -0.31829   1.90  25.00   86.98953    0.67361    0.84687
   1   -0.31610   1.90  25.00   86.98953    0.68773    0.86122
   2   -0.31603   1.90  25.00   86.98953    0.69522    0.87607
   3   -0.31882   1.90  25.00   86.98953    0.67496    0.89144
   4   -0.31651   1.90  25.00   86.98953    0.68968    0.90736
   5   -0.31536   1.90  25.00   86.98953    0.70494    0.92386
   6   -0.32428   1.80  23.00   87.24708    0.68393    0.93542
   7   -0.31554   1.90  25.00   86.98953    0.69945    0.95872
   8   -0.31327   1.90  25.00   86.98953    0.71578    0.97716
   9   -0.31454   1.80  23.00   87.24708    0.69591    0.99044
  10   -0.31451   1.90  25.00   86.98953    0.69099    1.01624

MLLF Results
------------
Point statistics:
Number                        =         52
Calculated density            =    0.00004
Real density                  =    0.00004

Results:
Mean log-likelihood           =   -0.31327
R, strain ratio               =    1.90000
Phi, angle of max strain axis =   25.00000
Cutoff radius                 =   86.98953
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Finished: 2014-05-31 22:49:58    

The results of pass 0 are identical to the previous result, however the cross-validation procedure located
a slightly better solution, in pass 8 the mean log likelihood is -0.31327, instead of -0.31829. The 
resulting Fry plot with 8 less neighbor points is shown in Figure 45. 

Kumar et al. (2014) concluded that the maximum likelihood method gave less accurate results than 
other methods, possibly because the non-random point distribution in their simulated samples violated 
the method’s requirement of a homogeneous truncated Poisson distribution. 

3.3.6 Weighted Least-Squares

The weighted least squares method attempts to minimize a least-squares function fitting a one-sided 
data cloud boundary by applying a high weighting to points that lie inside the boundary, and a weight 
of 1 to points that lie outside (Cardiel, 2009; Mulchron, 2013). The method used follows that of 
Mulchron (2013) and Mulchron et al. (2013), however using Delaunay neighbors is optional. 

Two options are provided for locating a solution. The first is an optimized search through the 
parameters, [b, R, ϕ], the void fit ellipse's short radius, axial ratio, and orientation of the long axis. The 
second option is to use function minimization (e.g., Press et al., 2007) which minimizes a function g[a, 
b, ϕ], where a is the void ellipse long axis radius. The parameters are selected as described in the 
sections on the density gradient and exponential edge detection methods respectively. The function g[a,
b, ϕ]  is the polar version of Mulchrone, 2013 (and Mathematica code of Mulchrone et al., 2013).

The minimization procedure, as is used in the exponential edge detection method, does not converge 
robustly for the weighted least-squares function, so an optimized parameter search should be used. The 
default optimized search settings increment R by 0.01 from 1 to 3, ϕ by 0.1° from 0 to 179.9, and B by 
100 increments over a selected range. 

The first example uses a weighted least squares search without using Delaunay nearest neighbors. 
Figure 46 shows the settings pane and Figure 47 is the preview of automatic function search options. 
The blue circles are the minimum and maximum search radii for the void ellipse short axis.
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The results of the weighted least-squares optimized search without using Delaunay nearest neighbors 
are plotted in Figures 48 and 49, and are as follows: 

46

Figure 46. Weighted least-squares settings pane 
after having set the automatic options for a 
search.

Figure 47. Preview of automatic weighted 
least-squares function search options. The 
blue circles are the minimum and maximum
search radii for the void ellipse short axis. 
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Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-20 16:24:07
==============================
N     : 252
Pairs : 3985
Time  : 00:00:21
Weighted Least Squares
  Normalize        : False
  Delaunay         : False
  Minimize         : False
  Iterations       : 47061
  ζ                : 2000
Best-Fit Ellipses
  Max      Min      R      ϕ       g
  25.8691  16.2699  1.590  27.60°  10193725
  25.8691  16.2699  1.590  27.50°  10193745
  25.8691  16.2699  1.590  27.40°  10193795
  25.8691  16.2699  1.590  27.30°  10193875
  25.7064  16.2699  1.580  27.60°  10193964
  25.7064  16.2699  1.580  27.50°  10193969
  25.7064  16.2699  1.580  27.40°  10194003
  25.7064  16.2699  1.580  27.30°  10194065
  25.7064  16.2699  1.580  27.20°  10194156
  25.7064  16.2699  1.580  27.10°  10194275
Mean of Best-Fit Ellipses
  n     = 10 ellipses
  R     = 1.584
  ϕ     = 27.39°
  R 95% = 0.004
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Figure 48. Plot showing best-fit ellipse 
determined from the automatically selected 
weighted least-squares function search 
options. The red ellipse  defines the best 
void fit ellipse. Delaunay nearest neighbors 
are not used.

Figure 49. Zoomed in view of Figure 48 
showing the void best-fit ellipse in red. The 
blue circles are the search range for the 
ellipse short radius. The clip radius is 40. 



EllipseFit User Manual

  ϕ 95% = 0.13°          

The second example is a weighted least-squares optimized search using Delaunay nearest neighbors. 
Clipping is turned off to use all points. These results are plotted in Figures 50 and 51, and are as 
follows: 

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-20 16:58:51
==============================
N     : 252
Pairs : 717
Time  : 00:00:04
Weighted Least Squares
  Normalize        : False
  Delaunay         : True
  Minimize         : False
  Iterations       : 46620
  ζ                : 2000
Best-Fit Ellipses
  Max      Min      R      ϕ       g
  18.3966  12.7754  1.440  19.90°  351694
  18.3966  12.7754  1.440  19.80°  351695
  18.3966  12.7754  1.440  19.70°  351697
  18.3966  12.7754  1.440  19.60°  351702
  18.3966  12.7754  1.440  19.50°  351707
  18.3966  12.7754  1.440  19.40°  351714
  18.3966  12.7754  1.440  19.30°  351723
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Figure 50. Plot showing best-fit ellipse 
determined for weighted least-squares 
Delaunay nearest neighbors search options.
The red ellipse defines the best void fit 
ellipse. are used. Clipping is off.

Figure 51. Zoomed in view of Figure 50 
showing the void best-fit ellipse in red. The 
blue circles are the search range for the 
ellipse short radius. The clip radius is 40. 
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  18.2688  12.7754  1.430  19.70°  351730
  18.2688  12.7754  1.430  19.60°  351730
  18.2688  12.7754  1.430  19.50°  351731
Mean of Best-Fit Ellipses
  n     = 10 ellipses
  R     = 1.437
  ϕ     = 19.60°
  R 95% = 0.004
  ϕ 95% = 0.17°

Identical results are obtained if B is incremented by 1000 increments over the 
selected range. 

The last example is a weighted least-squares optimized search using normalized Delaunay nearest 
neighbors. This requires the particle shape parameters [ai, bi, ϕi], so loses independence from ellipse 
fitting methods. Again, the optimized search settings increment R by 0.01 from 1 to 3, ϕ by 0.1° from 0
to 179.9, and B by 100 increments over a selected range, and clipping is off. The results are plotted in 
Figures 52 and 53, and are as follows:        

Void Fit Results
E2 - Ramsay and Huber 1983 (small)
2017-02-20 17:04:58
==============================
N     : 252
Pairs : 717
Time  : 00:00:04
Weighted Least Squares
  Normalize        : True
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Figure 52. Plot showing best-fit ellipse 
determined for weighted least-squares 
normalized Delaunay nearest neighbors. 
The red ellipse defines the best void fit 
ellipse. Clipping is off.

Figure 53. Zoomed in view of Figure 50 
showing the void best-fit ellipse in red. The 
blue ellipse is the initial estimate. The clip 
radius is 1.5. 
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  Delaunay         : True
  Minimize         : False
  Iterations       : 47061
  ζ                : 2000
Best-Fit Ellipses
  Max     Min     R      ϕ       g
  0.8243  0.4293  1.920  24.40°  209
  0.8243  0.4293  1.920  24.30°  209
  0.8243  0.4293  1.920  24.20°  209
  0.8243  0.4293  1.920  24.10°  209
  0.8243  0.4293  1.920  24.00°  209
  0.8243  0.4293  1.920  23.90°  209
  0.8243  0.4293  1.920  23.80°  209
  0.8243  0.4293  1.920  23.70°  209
  0.8261  0.4258  1.940  24.20°  209
  0.8261  0.4258  1.940  24.10°  209
Mean of Best-Fit Ellipses
  n     = 10 ellipses
  R     = 1.924
  ϕ     = 24.07°
  R 95% = 0.006
  ϕ 95% = 0.16°  

3.3.7 Error Analysis

Bootstrap error analysis (Efron, 1979) offers a powerful technique for calculating confidence regions. 
The technique is nonparametric, meaning that it is not necessary to assume the sample comes from a 
population with a particular distribution, and it may be applied to small samples, less than 25 data 
points. The basic idea is that replicates of the sample are created by random resampling with 
replacement, and the mean is calculated of the resample, This is done hundreds or thousands of times to
create a sample of means. The dispersion in these means is used to determine confidence intervals 
(Figures 21, 22, 23, 24, 30, 31, 40, 41, 42, and 43). 

Bootstrap error analysis is feasible for the Fry plot void fitting routines that are not overly time 
intensive (Table 2). It is done by resampling the data point sample to construct new Fry plots, and 
recalculating the void-fit mean, in these examples 1000 times. In contrast, McNaught (2002; cf., 1994),
suggested a bootstrap technique resampling the Fry points of a single plot 100 times. While a complete 
analysis has not been done, creating resamples using the original data points instead makes intuitive 
sense, and, given the speed of some of the algorithms implemented in EllipseFit, a minimum of 500 to 
1000 resamples is suggested (Vollmer, in preparation).

3.3.8 Comparison of Void Fitting Methods

As discussed previously, Kumar et al. (2014) reviewed six void fitting methods, including Delaunay 
triangulation nearest neighbors (DTNN), density contrast (point-count), exponential edge detection 
(EED, or continuous function), and mean log likelihood methods, using two-dimensional simulated 
data sets, and concluded that of those six, the EED method is the most accurate, followed by the DTNN 
method. The weighted least-squares method with the Delaunay option implemented here follows 
DTNN. 
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Table 2 is a summary of the results of the example analyses presented in this chapter. The results of 
additional tests on three-dimensional natural and simulated samples are in preparation (Vollmer, in 
preparation). While the examples presented here are a limited set of tests, some conclusions were 
drawn after extensive time implementing and testing the various methods. Note that while the code has 
been carefully checked, it is possible that there are implementation errors.

Of the methods that are independent of particle shape [ai, bi, ϕi], and only depend on [xi, yi] (Table 2), 
the exponential edge detection (EED) method is robust (Figures 40 and 41), and fast so bootstrap 
confidence intervals can be calculated in a few minutes. The density contrast method requires a 
parameter search, so is relatively slow and less suitable for bootstrapping. Kumar et al. (2014) 
concluded that it was less accurate. The weighted least-squares function method was found to be 
difficult to minimize robustly, so a parameter search is used. The maximum likelihood method (Shan 
and Xiao, 2011) is slow, and was concluded by Kumar et al. (2014) to gave less accurate results.  

Of the methods that also require particle shape, [ai, bi, ϕi], the enhanced normalized method is fast, 
robust, and suitable for bootstrapping (Figures 23 and 24). Restricting the method to Delaunary nearest 
neighbors speeds up the analysis further, but reduces confidence (Figures 30 and 31, Table 2). The 
normalized exponential edge detection (NEED) method is also fast and robust (Figures 42 and 43). 
This method, as does the weighted least-squares method, fit the void edge, rather than points near the 
cloud around the edge, which may provide an advantage. The normalized Delaunay weighted least-
squares method was found difficult to minimize robustly, so the slower parameter search is used.

Method R ϕ R 95% ϕ 95% XY Only

Enhanced 1.662 25.83° 0.134 3.34°

Enhanced Normalized 1.622 24.43° 0.078 1.84° 

Enhanced Normalized Delaunay 1.621 24.45° 0.621 14.75°

Density Contrast 1.570 28.00° √

Exponential Edge Detection (EED) 1.637 25.53° 0.165 4.83° √

Normalized Exponential Edge Detection (NEED) 1.740 24.85° 0.124 2.71° 

Mean Log Likelihood (N = 60) 1.900 25.00° √

Weighted Least-Squares 1.590 27.60° √

Delaunay Weighted Least-Squares (DTNN) 1.440 19.90° √

Normalized Delaunay Weighted Least-Squares 1.920 24.40°

Eigenvector mean 1.627 25.74° 0.035 0.84°

Table 2 Summary of example results of void fitting methods on data file E2 - Ramsay and Huber 1983 
(small). Bootstrap confidence intervals are given if implemented, bootstrapping was not implemented if
impractical due to the required processing time (Section 3.3.7). The eigenvector results for the particle 
mean ellipse are given for comparison.

51



EllipseFit User Manual

4. Analysis of Line Data

4.1 Analytical Wellman Analysis 
The Wellman method can be applied to objects in which two lines can be identified that have constant 
initial angles, such as brachiopod hinge and medial lines which are initially perpendicular (Wellman, 
1962; Ramsay, 1967). For brachiopods not parallel to a principal strain, this angle will be distorted by 
shear strain. 

Wellman's graphical technique is illustrated in many structural geology laboratory manuals (e.g., 
Ragan, 2009). An analytical solution to the problem was given by Vollmer (2011), which is 
implemented in implemented in EllipseFit. To try the method, open the file 

LA - Ragan 1985 F10_1a.png

as an image. This is from Ragan (1985), and is used in many structural geology classes as an exercise. 
To begin click on the digitizing icon until the Line Pair icon is displayed, or use the menu command 
Digitize Line Pair. For each brachiopod click on the endpoints of each of the two lines, the hinge line 
and medial line. When done the lines appear in red, and the yellow cursor appears at the intersection. 
Mistakes can be corrected by using the Cut icon, or by deleting the line pair in the Data Window.
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After digitizing one line pair, open the Wellman Plot using the menu command Analyze > Wellman 
Plot. The plot shows the parallelogram corresponding to the brachiopod (Figure 55). The parallelogram 
sides parallel the line pair. Note the two additional points used for the construction.

Continue digitizing the remaining line pairs. Figure 56 shows the plot after three line pairs. The yellow 
cross cursor highlights the corresponding data point intersection and parallelogram, and the data is 
selected in the Data Window.  If the Find icon is pressed, as in Figure 56, you can search on the plot to 
locate the corresponding data. As in digitizing points, this allows the identification of outliers or 
spurious data.
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Figure 54. The Image window 
after opening the example data 
from Ragan (1985). The hinge 
and medial lines are assumed 
initially perpendicular. One line 
pair has been digitized. Note the 
Line Pair tool icon is visible.
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Figure 57 shows the final analytical Wellman plot after all 8 line pairs have been digitized. Examine the
Log Window (Window > Log) and note that at each step EllipseFit calculated the best-fit ellipse. 
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Figure 55: The analytical Wellman plot after 
digitizing one line pair as in Figure 26. Note the 
Find icon is selected and that the parallelogram 
and corresponding brachiopod are selected with 
the yellow cursor. 

Figure 57: The final analytical Wellman plot 
after all 8 line pairs from the brachiopods in 
Figure 27 have been digitized.

Figure 56: The analytical Wellman plot after 
three line pairs have been digitized.
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Analytical Wellman Ellipse Results
LA - Ragan 1985 F10_1a
2017-07-08 19:37:46
==============================
N             = 8
Points fitted = 18 (symmetric)
R             = 1.799
ϕ             = 95.18°
n             = 18
RMS           = 0.064

The ellipse-fitting calculation used is a non-iterative constrained least-squares technique minimizing 
the sum of the squares of the residuals of the points from an ellipse using the minimum positive 
eigenvalue (Fitzgibbon et al., 1996; Halır and Flusser, 1998). The RMS value is the root mean square 
measure of the variation of the residuals from the ellipse, that is the square root of the sum of the 
squares of the residuals of the data from the fitted ellipse. It is a measure of goodness of fit of the 
ellipse, but is not technically an error. The RMS will be zero  for two line pairs. The calculation 
includes the constriction line, so the ellipse has 9 point pairs including the 8 data points.

In theory, objects like graptolites that have a constant, non-perpendicular, angle between stipe and 
thecae, can be treated in the same fashion (Ramsay, 1967). Dirringer and Vollmer (2013) compared the 
automated Wellman method and the mean polygon moment ellipse method (Section 5.1) using a sample
of slate with deformed Ordovician graptolites. The sample was oriented with the slaty cleavage as the 
X axis. The center lines and lower thecae lines were digitized in 120 locations for the Wellman test, 
only one species had clearly defined thecae lines. The outlines of 31 whole graptolites and 38 partial 
graptolites were digitized for the polygon method test. 

The mean polygon moment ellipse was R = 2.079 ± 0.122, ϕ = 177.48° ± 4.57°, parallel to the slaty 
cleavage. The polygon method does not require assumptions about initial shapes, only that they are 
initially random. Interpreting the data for the analytical Wellman method was problematic, as it many  
outliers around a central ellipse. Removal of 77 outliers, believed to be due to initial variations in 
thecae angle, was required before the ellipse could be clearly resolved. While most outliers could be 
clearly identified, the process was subjective, and single outliers significantly effected the result. The 
result for 43 data points was R = 2.761, ϕ = 0.50°, RMS = 0.294, parallel to cleavage.   

They concluded that the necessary assumptions about initial geometry for the analytical Wellman 
method were not met, and the polygon method, with no such required assumptions about initial 
geometry, was preferred. 
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Figure 58. Sample of deformed graptoliferous slate used by Dirringer and Vollmer 
(2013) for comparison of the automated Wellman and mean polygon moment 
ellipse methods.
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4.2 Line Stretch Analysis 
A line stretch analysis is used for lines of known initial lengths (l i), final lengths (lf), and final 
orientations (αf). Folds and boudins are common examples of this type of data, where initial lengths can
be measured along folded layers, or boudin segments (Mitra, 1978; Ramsay and Huber, 1983). Possible
layer parallel shortening or extension complicates the analysis, and may be difficult to evaluate.

The analytical approach taken here is to use the line stretches, S = l f / li, as ellipse radii with 
orientations αf, to construct diametrically opposed point pairs.  As in Section 4.1, the ellipse-fitting 
calculation used is a non-iterative constrained least-squares technique minimizing the sum of the 
squares of the residuals of the points from an ellipse using the minimum positive eigenvalue 
(Fitzgibbon et al., 1996; Halır and Flusser, 1998). The RMS value is the root mean square measure of 
the variation of the residuals from the ellipse, that is the square root of the sum of the squares of the 
residuals of the data from the fitted ellipse.   
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Figure 59. The graptoliferous slate sample of 
Figure 24 after retrodeforming to remove the 
strain calculated by the mean polygon 
moment ellipse method, R = 2.079, ϕ = 
177.48°



EllipseFit User Manual

5. Ellipse and Polygon Analysis
This chapter discusses methods for displaying and analyzing fabric ellipse data derived from particle 
ellipses or polygons. This includes an important mathematical proof that allows polygons to be treated 
as ellipses. Plots of ellipse data are essential for evaluating fabric data, the commonly used R f / ϕ and 
Elliott polar plots can been shown to be types of hyperboloidal projections, which has important 
implications for understanding their properties, and other hyperboloidal plots also have important 
properties useful for strain analysis. Contouring fabric data on these plots allows examination of fabric 
samples for outliers, multiple modes, and asymmetries. Finally, the calculation of mean ellipses, and 
error analysis, are important components in the evaluation of fabric data for strain analysis.

5.1 Moment-Equivalent Ellipses
Numerous techniques for the analysis of populations of ellipses for strain analysis have been 
developed, as have more specialized methods for deformed fossils and other objects of known initial 
geometries (Ramsay, 1967; Ramsay and Huber, 1983). Mulchrone and Choudhury (2004), however, 
showed that ellipse methods can be extended to arbitrary shaped objects by using ellipses that have the 
same first and second order moments, referred to here as moment equivalent ellipses. This allows 
randomly oriented objects of any initial shape to be used in strain analysis, thus extending ellipse 
techniques to polygons. The calculation of moment equivalent ellipses in EllipseFit is done in two 
ways. First the Polygon digitizing option allows direct, potentially sub-pixel, digitizing of polygons 
which are converted to ellipses (Section 2.2.5). Second, the Filled polygon digitizing options uses pixel 
summation, similar to routines in ImageJ and MATLAB, to calculate moment equivalent ellipses 
(Section 2.2.6). Note that these techniques for calculating ellipses are not least-squares best fit ellipses 
(e.g., Erslev and Gee, 1990).

5.2 Ellipse Plots
In order to evaluate a sample of fabric ellipses prior to further analysis, it is important to plot the data in
a way that can identify outliers, modes, and asymmetries. Such a plot is an exploratory evaluation of 
the density distribution of the data to determine if it can be characterized statistically by a mean and 
confidence interval, or if it represents a more complex distribution. The R f / ϕ plot (Ramsay, 1967; 
Dunnet, 1969) and Elliott polar plot (Elliott, 1970) are standard plots for ellipse data. It can be shown 
that these are equidistant hyperboloidal projections, and that other such projections also have useful 
properties for strain analysis. 

5.2.1 Elliott Polar Plot

The Elliott polar plot (Elliott, 1970) is a polar plot of the natural log R versus 2ϕ. As discussed in 
Section 5.2.3, this plot is an equidistant azimuthal hyperboloidal projection (Yamaji, 2008; Vollmer, 
2011; Vollmer, in review). While all projections have inherent distortion, this plot does not distort strain
magnitude radially, and therefore generally provides a better representation of data than the R f / ϕ plot 
described in Section 5.2.2.
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Figure 60 is an Elliott polar plot of the data digitized from the oolith photomicrograph in Figure 1. The 
ellipse mean (Section 5.4) is plotted, and the data has been contoured at 20% of the density distribution 
(Section 5.3). Most of the plots in EllipseFit are interactive. When in plot Find mode, points can be 
selected and the selection will automatically update on other plots and in the Data Window. To illustrate
the utility of this for detecting data outliers, Figure 61 shows a Fry plot with the points generated by the
outlier selected in Figure 60. This outlier falls well inside the central void on the Fry plot, probably 
does not meet the assumptions necessary for a Fry analysis, and could reasonably be discarded. Note 
that this point lies outside the 20% density contour.

5.2.2 Rf / ϕ Plot

The Rf / ϕ plot (Ramsay, 1967; Dunnet, 1969) is a Cartesian plot of Rf, or more commonly natural log 
Rf, versus ϕ, and is widely used in strain analysis (e.g., Ramsay and Huber, 1983; Lisle, 1985). 
Although the original plot had Rf, as the ordinate, it has been presented with either variable as the 
ordinate. This plot is probably more widely recognized and used than the polar Elliott plot, but it has 
more distortion at low strains.

The Rf / ϕ plot is an equidistant cylindrical hyperboloidal projection (Section 5.2.3), and distorts the 
strain space strongly at low strains (Vollmer, 2011; Vollmer, in review). By analogy, a Mercator 
projection of the Earth projects the North and South Poles as lines, causing large distortion in polar 
regions, Greenland appears larger than South America on such a map, although it is one eighth the size 
(Snyder, 1987). Similarly, the Rf / ϕ plot projects the point of zero strain to a line, effectively stretching 
it along the Rf  = 1 axis. 
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Figure 60. Polar Elliot plot with digitized data 
from the oolith photomicrograph in Figure 1. 
The mean is shown in red, and the data has been 
contoured at 20% of the density distribution. 
One outlier is selected.

Figure 61. Fry plot with data dititized from the 
oolith photomicrograph in Figure 1. The selected
points are those generated by the outlier selected
in the polar plot of Figure 60.
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As is the case for the Elliott plot (Section 5.2.1), an Rf / ϕ plot can display the mean ellipse and 
contours on the density distribution (Section 5.3). Figure 62 is an Rf / ϕ plot with digitized data from 
the oolith photomicrograph in Figure 1, note the stretching near R = 1. The mean is shown, and the data
has been contoured at 20% of the density distribution (Section 5.3). One outlier is selected, the same as 
in Figures 60 and 61, each of which are automatically updated interactively.

60

Figure 62. Rf / ϕ plot with digitized data from 
the oolith photomicrograph in Figure 1, note the 
stretching near R = 1. The mean is shown in red,
and the data has been contoured at 20% of the 
density distribution. One outlier is selected, the 
same as in Figures 60 and 61, each of which are 
automatically updated interactively.
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5.2.3 Hyperboloidal Plots

See Reynolds (1993), Yamaji (2008, 2013) and Vollmer (2011 and in review).
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Figure 63. The unit hyperboloid, H2, 
showing cartesian axes, x0, x1, x2, and 
point C = (1, 0, 0), which corresponds to 
the circle R = 1. The plane x1x2 is the 
projection plane for azimuthal projections, 
such as the Elliott polar plot. Points on H2 
are x = (x0, x1, x2)T, with origin C. If strain 
is represented by (ρ, ψ) = (log R, 2ϕ), then 
an ellipse is x = (cosh ρ, sinh ρ  cos  ψ,  
sinh ρ  sin  ψ)T . From Vollmer, in review.

Figure 64. The unit hyperboloid with 
superimposed cylinder with axis x0 ≥ 1. The 
cylinder is the projection surface for 
cylindrical projections, such as the Rf / ϕ 
plot. From Vollmer, in review.
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5.3 Contouring
See Vollmer (2011a; in review).
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Figure 65. Synthetic data of 300 ellipses strained to values of
R = 2 and R = 4 displayed on hyperboloidal azimuthal 
projections: (a) equidistant, (b) stereographic, (c) equal-area, 
(d) orthographic, and (e) gnomic.The best-fit ellipse is 
plotted as a white circle, the centroid of the projected data is 
plotted as a gray circle. From Vollmer, 2011a.



EllipseFit User Manual

5.4 Mean Ellipse Calculation
Determination of the best-fit, or mean, ellipse from a sample of fabric ellipses is of considerable 
importance for geological strain analysis and numerous graphical and mathematical techniques have 
been proposed, including various arithmetic means, ellipse plot centroids, and fitting of R f / ϕ data to 
theoretical curves (e.g., Ramsay, 1967;  Ramsay and Huber, 1983; Lisle, 1985). The most rigorous 
approach, however, is a direct numerical calculation of the mean (Shimamoto and Ikeda, 1976; 
Mulchrone et al., 2003; Yamaji, 2008).

5.4.1 Simple Means and Centroids

The Centroids and Simple means option gives approximations less accurate than the true mean, and are
provided for comparison only. This includes vector, arithmetic, and harmonic means. The centroids of 
the polar and Rf / ϕ plots can be plotted for comparison, but should not be confused with the actual 
mean. Note in particular, that the centroid of the polar Elliot plot is close to, but is not equivalent to the 
true mean, this error increases with strain. The centroid of the Rf / ϕ plot is not a reliable estimate, and 
can deviate significantly from the true mean (Vollmer, in review).

5.4.2 Shape Matrix Eigenvector

Shimamoto and Ikeda (1976) devised a numerical solution to calculate a mean ellipse involving the 
determination of the eigenvectors of the mean shape matrix (sometimes later referred to as the inverse 
shape matrix), a two by two matrix representing an ellipse, formed by summing the components of 
particle ellipses, normalizing the matrix, and computing the eigenvectors to give the mean ellipse, 
essentially a way of determining a mean for a matrix quantity. They extended this method to three-
dimensional ellipsoids, but more general approaches have since been devised (Section 6.3).

5.4.3 Mean Radial Length

Mulchrone et al. (2003) devised a mean ellipse calculation that determines the mean radial length 
(MRL). This calculation does not require eigenvector calculation, giving an advantage if an eigenvector
calculation is not available. However, most numerical software contains fast eigenvector calculations, 
so the MRL calculation does not necessarily offer an advantage in simplicity of implementation or 
processing speed. 

5.4.4 Hyperbolic Vector Mean

Yamaji (2008) showed that using non-Eucledian hyperbolic geometry, the mean is calculated simply as 
the hyperbolic vector mean. This provides an elegant mathematical solution which illustrates the 
simplicity and utility of the hyperboloid model in understanding strain transformations and projections. 
In terms of programing, the algorithm is simple, but transformations to and from hyperboloidal 
coordinates can slow the calculation.  

5.4.5 Comparison of Mean Calculations

When calculating the mean ellipse using the Calculate Ellipse command, the method is selected in the 
Calculate Ellipse dialog, from the Eigenvector, Mean radial length, and Hyperbolic mean options. 
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These three methods are mathematically equivalent, and have been verified to give identical results 
(Vollmer, 2010; Table 3), so only one need be selected. EllipseFit uses the shape matrix eigenvector 
method (Shimamoto and Ikeda, 1976), which is marginally faster, by default. The speed differential 
between the three methods is small, and is only important during bootstrap analysis (Section 5.5.2), 
when thousands of such calculations may be made. The simple means and centroids are only provided 
for comparison, and may be considered as approximations to the mean.

Data Set Imposed (R, ϕ) Eigenvector MRL Hyperbolic

Oolith 1, 0 1.628, 25.74 1.628, 25.74 1.628, 25.74

n = 252 ±  0.018, 0.73  ± 0.018, 0.62  ± 0.013

0.614, 25.74 1.000, 113.32 1.000, 113.32 1.000, 113.32

 ± 0.007, 55.27  ± 0.011, 633.74 ± 0.013

Synth 1 1, 0 1.031, 40.20 1.031, 40.20 1.031, 40.20

n = 300 ± 0.021, 33.24 ± 0.025, 22.81 ± 0.030

2, 0 2.012, 1.16 2.012, 1.16 2.012, 1.16

± 0.048, 1.16 ± 0.050, 0.92 ± 0.032

4, 0 4.023, 0.46 4.023, 0.46 4.023, 0.46

± 0.101, 0.53 ± 0.099, 0.37 ± 0.031

Synth 2 1, 0 1.016, 146.03 1.016, 146.03 1.016, 146.03

n = 1000 ± 0.012, 35.35 ± 0.014, 24.51 ± 0.016

2, 0 2.012, 179.46 2.012, 179.46 2.012, 179.46

± 0.026, 0.71 ± 0.27, 0.51 ± 0.016

4, 0 4.024, 179.78 4.024, 179.78 4.024, 179.78

± 0.052, 0.30 ± 0.053, 0.21 ± 0.017

Table 3. Comparative results for ellipse-fitting techniques implemented in EllipseFit. Eigenvector = 
Shape matrix eigenvectors (Shimamoto and Ikeda, 1976). MRL = Mean radial length (Mulchrone, et 
al.,  2003; Mulchrone, 2005). Hyperboloidal = Hyperbolic vector mean (Yamaji, 2008). All three 
calculation give identical results. The 95% confidence intervals are calculated differently in each, 
however, so differ (Section 5.5). From Vollmer (2010).

5.5 Error Analysis

5.5.1 Analytical Error

Mulchrone (2005) gave a method for determining an analytical error for the mean radial length (MRL) 
method of strain analysis. The analytical errors are calculated using this method when the MRL is 
calculated.
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5.5.2 Bootstrap Analysis

As discussed in Section 3.3.7 for the void-fitting methods, bootstrap error analysis (Efron, 1979) offers 
a powerful technique for calculating confidence regions. The technique is nonparametric, meaning that 
it is not necessary to assume the sample comes from a population with a particular distribution, and it 
may be applied to small samples, less than 25 data points. The basic idea is that replicates of the sample
are created by random resampling with replacement, and the mean is calculated of the resample, This is
done hundreds or thousands of times to create a sample of means. The dispersion in these means is 
used to determine confidence intervals (Figure 66). 

Bootstrap error analysis is readily done for mean ellipse calculations (Section 5.4). While the 
resampling technique is straightforward, one question involves the choice of parameter space to be 
used for the confidence intervals. That is, if R and ϕ are to be considered as independent parameters 
(Mulchrone et al., 2003), or if the hyperbolic distance, dH, is considered as a single parameter (Yamagi, 
2013). In the former case, when R ≈ 1, the confidence interval for ϕ is likely to be very large because it 
has little significance (Table 3). Both options are implemented in EllipseFit.
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Figure 66. Error analysis is shown by an 
equidistant azimuthal plot of bootstrap results of 
1000 resamples from oolite data. The mean 
vector of the bootstrap mean vectors is rotated to
C (R = 1). The dispersion of the points is a 
measure of the error in the best-fit ellipse. 
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6. Strain Ellipsoids 
For regional strain studies it is generally necessary to determine the three-dimensional strain ellipsoid, 
with three stretches and their orientations, normally expressed as trends and plunges. This can be 
simplified if assumptions can be made about the relationship between foliations and strain, for example
slaty cleavage is commonly assumed perpendicular to the minimum stretch. However, in the general 
case it is necessary to determine the two-dimensional strain on a number of different planes through a 
hand sample or outcrop, and combine them to determine the strain ellipsoid in three dimensions. This is
a difficult mathematical problem, and numerous solutions have been proposed (e.g., Shimamoto and 
Ikeda 1976; Owens, 1984; Robin, 2002; Shan, 2008; Mookerjee and Nickleach, 2011). EllipseFit 
implements the method of Shan (2008) as discussed in Section 6.3.

6.1 Ellipsoid Plots

6.1.1 Flinn Plot

A Flinn plot is a plot of the ratios A/B = SMax/SInt versus B/C = SInt/SMin, and is commonly used for 
displaying strain ellipsoid data (e.g. Ramsay and Huber, 1983). As with the ellipse plots, the Flinn and 
Nadia plots are interactive, selecting a point in one will automatically select the corresponding data 
point on the other plot, and in the Data Window.
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6.1.2 Hsü-Nadai Plot

The Hsü-Nadai plot (Nadia, 1950; Hossack, 1968; Section 9.2) is based on natural, or logarithmic 
strain, which is also the basis for the hyberboldal projections discussed in Section 6.3. This provides an 
undistorted representation of the deviatoric strains and is preferred by many for that reason (Brandon, 
1995).
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Figure 67. Log Flinn plot displaying deformed pebble ellipsoids, 
Bygdin area, Norway, from Hossack, 1968. This plot is 
interactive, with the Find Tool selected, data points can be 
selected and will be simultaneously updated on the Nadai plot 
and in the Data Window, the selected data point is also displayed
in Figure 68.
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Figure 68. Hsü-Nadia plot displaying deformed pebble 
ellipsoids, Bygdin area, Norway, from Hossack, 1968. This plot 
is interactive, with the Find Tool selected, data points can be 
selected and will be simultaneously updated on the Flinn plot 
and in the Data Window, the selected data point is also displayed
in Figure 67.
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6.2 Global Coordinates and Sample Collection
The two-dimensional strain ellipses considered thus far have been referred to X, Y coordinates, where 
X is to the right, and Y is down the image. These coordinate axes are indicated by the blue lines on the 
top and left of the Image Window. The angle ϕ is the positive angle (clockwise) from X. This 
coordinate system was chosen to simplify the relationship to the global coordinates referred to here as 
X', Y', Z', and to simplify the calculation of the three-dimensional strain ellipsoid. The global 
coordinates are equivalent to North, East, Down (NED).

In Figure 70 the shaded plane is a section plane that corresponds to an image analyzed for two-
dimensional strain as discussed in earlier chapters. The X axis is parallel to the strike of the plane, 
using the (American) right hand rule (Pollard and Fletcher, 2005; Twiss and Moores. 2007; Fossen, 
2016), as shown in Figure 70. The strike is given by θ, the standard azimuth as a clockwise angle from 
North in degrees. The dip of the plane is the angle δ from horizontal. The calculated strain ellipse is 
given by R = A/B = LMax/LMin, and ϕ, the angle from X, which is its pitch in global coordinates. The 
described ellipse in an oriented section is referred to here as a section ellipse.
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Figure 69. Deformed pebble conglomerate, Bygdin area, Norway, where the data plotted  in 
Figures 67 and 68 was collected by Hossack (1968). Photograph by F. W. Vollmer. 
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In order to calculate the strain ellipsoid from the section ellipses, each section ellipse must undergo a 
coordinate transformation from local X, Y coordinates to global X', Y', Z' coordinates. This is done 
automatically by EllipseFit, but the user must take great care to properly prepare samples. Time taken 
at this stage will save much aggravation later on. A sample collected in the field must be carefully 
oriented, recording its strike and dip (other conventions are fine, but the strike is the X coordinate axis 
so is used here). A suitable marking is a strike arrow and a dip tick (Figure 70), if possible on a surface 
that is not overhanging.

A minimum of three sections must be made through the sample, although more is preferred. Shan's 
method relaxes this requirement if lineation data is used as well, but Vollmer (2010) showed that the 
error range in natural samples can be large, so a minimum of three sections is recommended. If 
available, lineation data can supplement the section ellipses (Section 6.3.1).

The sections should be made at high angles to each other, but it does not need to be 90°, a restriction of 
some methods (e.g., Shimamoto and Ikeda, 1976). In making thin sections be careful not to destroy the 
strike arrow and dip tick (it happens). The sample can then be taken outside, away from magnetic 
fields, and reoriented. The strikes and dips of the section planes can then be measured, and a strike 
arrow and dip tick marked on each face. The faces can then be photographed, or thin sections made, 
and photographed. Keeping thin sections correctly oriented is challenging, keep the strike arrow 
parallel to one side and pointing right.
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Figure 70. Coordinate system for section 
ellipses. The global coordinates are X' = North, 
Y' = East, and Z' = Down (NED). The plane 
with the section ellipse has a strike, θ (using the 
right hand rule), and dip, δ. The section ellipse 
has a pitch, ϕ, and R = A/B, where A and B are 
the maximum and minimum axes. A suggested 
strike arrow and dip tick for marking a sample is
shown.  
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To minimize confusion, make sure each photograph is oriented with the section strike to the right, and 
with the dip line down. Careful photography is best, but EllipseFit can rotate an image an arbitrary 
amount if necessary (Chapter 9). It is better to do it now than after digitizing the data, although 
EllipseFit can rotate the data if needed (Chapter 7).  

One last important detail is to keep track of the viewing direction. The strike arrow must point to the 
right in the section image. This means it is dipping towards you. If the strike arrow points left, you are 
looking at the underside of the section and it is dipping away from you. If so, you need to flip the 
image horizontally about a vertical axis. EllipseFit can do this (Edit > Rotate Image > Flip Horizontal), 
and it is better to fix the image before digitizing. Vertical sections are not a problem if the recorded 
strike is kept to the right in the images.

 If one is lucky to have outcrops with well exposed sections the process is greatly simplified, but the 
same principles apply.

6.3 Ellipsoid Calculation
Shan's method for determining the strain ellipsoid from section ellipses has similarities to the methods 
of Owens (1984) and Robin (2002), as they are all direct non-iterative calculations. Shan's method, 
however, also allows the inclusion of stretching lineation data, so has additional flexibility. Ellipsoids 
can be represented by shape matrixes, and the solution desired is the optimal shape matrix. Each 
section ellipse, or section lineation, adds one or two linear equations describing the shape matrix, which
can be solved as an eigenvalue problem. Shan solved the problem by assuming the matrix can be 

71

Table 4. Data file field headers and corresponding symbols. The headers define columns 
in data files read and written by EllipseFit. . 

Fields Alternate Symbol Definition
ID N Datum identification number
X', Y', Z' Global coordinates (North, East, Down)
X, Y Local coordinates, normally strike and dip line
Strike Theta θ Strike of section following right-hand rule
Dip Delta δ Dip of section plane from horizontal
Max, Int, Min A, B, C Axes of an ellipsoid
Max, Min A, B Axes of a sectional ellipse
R Strain ratio, Max/Min
Phi Pitch ϕ Angle in XY from X to ellipse axis Max
R* Best-fit estimate of R
Phi* ϕ* Best-fit estimate of ϕ
Delta R ΔR Misfit between R* and R
Delta Phi Δϕ Misfit between ϕ* and ϕ
S1, S2, S3 S1, S2, S3 Principal stretches
Trend t1, t2, t3 Trend of ellipsoid axis
Plunge p1, p2, p3 Plunge of ellipsoid axis
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located on a six-dimensional hypersphere centered at the origin, and recognized that the smallest 
eigenvector of the data matrix is the optimal solution. 

Before giving an example calculation, it is useful to compare it with some other methods. Shan's 
method has been tested on synthetic and natural samples, the following are some of the results of 
Vollmer (2010). Owens (1984) tested his method on a sample of slate from Dinorwic North Wales, for 
which the strains had been calculated from reduction spots on 8 sections. His data was also used by 
Launeau and Robin (2005) to test Robin's (2002) method. Table 5 shows results of Vollmer's (2010) 
tests on Shan's method using Owen's data.

The test involves calculating the strain ellipsoid from the section ellipses, then from the calculated 
ellipsoid, determining the two-dimensional sections corresponding to the input data. These are reported
as R*, ϕ* in the table. The difference is a residual. These are reported as ΔR, Δϕ in the table. An 
additional result is shown by using the calculated section ellipses to calculate an ellipsoid. These are 
reported as ΔRT, ΔϕT, and are negligible indicating success in retrieving the ellipsoid. Table 6 shows 
the results of the ellipsoid calculation from this sample as calculated using the methods of Owens 
(1984), Robin (2002), and Shan (2008). The results are compared graphically in Figure 71. The 
calculations and plots were done in EllipseFit 2 (Vollmer, 2011) and Orient 2 (Vollmer, 2012). There 
negligible differences between the results using the methods of Robin and Shan, the results using the 
method of Owen deviate a small amount from them.
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Table 5.  Results of test of Shan's (2008) method using data from Owens (1984). R*, ϕ* 
are the calculated b* (Table 4) section ellipses. Misfits ΔR, Δϕ indicate the error between 
calculated and measured ellipses. Calculated section ellipses were used to back-calculate 
bT* (Table 4) and RT*, ϕT*.  Misfits ΔRT, ΔϕT indicate that the method does retrieve b*.
From Vollmer (2010).

j θ δ A B R ϕ R* ϕ* ΔR Δϕ RT* ϕT* ΔRT ΔϕT
1 302 78 16.5 4.5 3.670 165 3.083 165.700 0.587 0.700 3.082 165.700 0.002 0.000
2 301 77 9.5 3.5 2.710 166 3.076 165.380 0.366 0.620 3.075 165.380 0.005 0.000
3 302 75 20.5 6.8 3.010 166 3.024 165.310 0.014 0.690 3.023 165.310 0.003 0.010
4 201 71 37.0 6.0 6.170 173 6.418 172.780 0.248 0.220 6.420 172.780 0.001 0.000
5 178 71 7.5 1.5 5.000 0 4.618 179.090 0.382 0.910 4.618 179.090 0.002 0.000
6 18 79 16.7 3.0 5.570 10 5.923 7.870 0.353 2.130 5.924 7.870 0.004 0.000
7 17 78 22.0 4.0 5.500 8 5.792 7.710 0.292 0.290 5.793 7.710 0.003 0.000
8 19 78 18.0 3.0 6.000 7 5.987 8.200 0.013 1.200 5.989 8.200 0.001 0.000
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The file: 

ES - Owens 1984.csv

contains the 8 section ellipse data from Owens (1984). Open this file in EllipseFit. The data as 
displayed in the Data Window is shown in Figure 72. There are 8 section ellipses, for each there is the 
Max, and Min (the axial lengths LMax, LMin ), the strain ratio R =  Max / Min, Phi (ϕ), the pitch of R 
from the X axis (X = strike), the strike angle  (θ), and the dip angle (δ) (see Figure 70). This is data 
then, that, in EllipseFit, would be determined from oriented photographs of each of the 8 sections.

Select the command Analyze > Calculate Ellipsoid and the Calculate Ellipsoid Dialog is displayed as in 
Figure 73. The results will be written to the Log Window. Checking Append results will append the 
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Table 6.  Comparison of calculated strain ellipsoids. Owens from  
Owens (1984). Robin from Launeau and Robin (2005), 
unweighted method of Robin (2002). Shan (b*) from Vollmer 
(2010), Shan's (2008) method. b** is a test to retrieve b*. The data
is plotted in Figure 71. From Vollmer (2010).

Figure 71. Comparison of calculated strain ellipsoids. O = Owens (1984). R = Launeau and Robin
(2005) using unweighted method of Robin (2002). S = EllipseFit using Shan's (2008) method. 
From Vollmer (2010).

Axis Owens Robin Shan (b*) b**
S1 2.340 2.626 2.565 2.567
t1 29.000 37.100 34.960 34.970
p1 10.000 11.300 10.890 10.890
S2 1.197 1.112 1.131 1.131
t2 122.000 129.500 127.350 127.360
p2 14.000 11.700 12.230 12.230
S3 0.357 0.343 0.345 0.345
t3 265.000 264.500 264.440 264.440
p3 73.000 73.600 73.510 73.510
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ellipsoid results to the open Data Window, so it can be plotted on Flinn and Nadia plots. Check Save 
orientations to save the trends and plunges of the principal axes to a file that can be opened in Orient 3 
(Vollmer, 2015) for plotting the axes on spherical projections. 

The Bootstrap option performs a bootstrap-type error analysis, using the number of resamples specified
in the Resamples edit box, 5000 is the default value. Finally, the Save bootstrap will save the 5000 
results of the resampling, which is normally unnecessary. Press OK to start the calculation. You will be 
prompted to save the orientation data files, and shortly the results appear in the Data Window (Figure
74) and the Log Window.

The Data Window now displays the ellipsoid principal axes Max, Int, Min as stretches (SMax, SInt, SMin), 
and 95% confidence intervals calculated by the bootstrap. The section ellipses show the back-
calculated values for R and ϕ, and the corresponding residuals. The last columns the distance residuals,
which are the hyperbolic distance residuals. 
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Figure 73. EllipseFit's Calculate Ellipsoid 
Dialog.

Figure 72. The section data from a sample of 
slate from Dinorwic, North Wales from Owens 
(1984), displayed in the EllipseFit Data Window.
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The Log Window reports the following:

Best-Fit Ellipsoid Calculations
ES - Owens 1984
2014-06-02 19:51:39
==============================
N = 8
Ellipsoid axes as stretches:
Maximum (A)      = 2.565
Trend            = 35.02
Plunge           = 10.90
Intermediate (B) = 1.132
Trend            = 127.41
Plunge           = 12.22
Minimum (C)      = 0.344
Trend            = 264.44
Plunge           = 73.51
Root mean square of section residuals:
R +/-            = 0.333
Phi +/-          = 0.85
Distance +/-     = 0.126
See data grid for section residuals
Bootstrap confidence intervals (5000 resamples)
Maximum (A):
  Stretch +/-    = 0.973
  Stretch 95%    = 1.385
  Stretch 99%    = 3.603
  Trend +/-      = 0.186
  Trend 95%      = 0.269
  Trend 99%      = 0.369
  Plunge +/-     = 0.037
  Plunge 95%     = 0.058
  Plunge 99%     = 0.083
Intermediate (B):
  Stretch +/-    = 0.106
  Stretch 95%    = 0.234
  Stretch 99%    = 0.415
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Figure 74. The Data Window after calculating the optimal ellipse using Shan's method.
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  Trend +/-      = 0.187
  Trend 95%      = 0.273
  Trend 99%      = 0.382
  Plunge +/-     = 0.041
  Plunge 95%     = 0.057
  Plunge 99%     = 0.073
Minimum (C):
  Stretch +/-    = 0.030
  Stretch 95%    = 0.063
  Stretch 99%    = 0.117
  Trend +/-      = 0.031
  Trend 95%      = 0.043
  Trend 99%      = 0.056
  Plunge +/-     = 0.014
  Plunge 95%     = 0.020
  Plunge 99%     = 0.026

This includes all 3 principal stretches, and their trends and plunges, with measures of error.  To view 
the results graphically, first select Analyze > Flinn Plot. A Flinn plot (Section 6.1.1) is a plot of the 
ratios A/B = SMax/SInt versus B/C = SInt/SMin. , and is commonly used for displaying strain ellipsoid data 
(e.g. Ramsay and Huber, 1983).

Now select Analyse > Nadia Plot, to display the results on a Nadai plot. A Nadai plot (Nadia, 1950; 
Hossack, 1968; Section 6.1.2) is based on natural, or logarithmic strain, which is also the basis for 
equidistant hyberboloidal projections discussed in Section 5.2.3. This provides an undistorted 
representation of the deviatoric strains and is preferred by many for that reason (Brandon, 1995).

76

Figure 75. Flinn plot of the ellipsoid axial ratios 
determined from the Shan calculation, with a 
95% confidence region. 
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The calculated strain has large 95% error region as shown in both plots. Examining the data (Figure
74), shows that section 6 has the largest distance residual. Select it, delete it and preform the ellipsoid 
calculation again. Figure 77 shows the updated Flinn plot, which now shows both solutions.

Similarly the Nadia plot has been updated to reflect the newly calculated results.

77

Figure 77. Flinn plot of the ellipsoid axial ratios 
determined from the Shan calculation, with 95%
confidence regions, after deleting section 6.

Figure 76. Nadai plot of the ellipsoid axial ratios
determined from the Shan calculation with a 
95% confidence region.
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Finally, the resulting axes are plotted on a lower hemisphere equal-area projection using Orient 
(Vollmer, 2010, 2015). The strain axes calculated from all 8 sections are plotted as circles, and the axes 
section 6 removed are plotted as diamonds. Red = SMax, green = RInt, blue = RMin. 
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Figure 78. Nadia plot of the ellipsoid axial ratios
determined from the Shan calculation, with 95%
confidence regions, after deleting section 6.

Figure 79. Lower hemisphere equal-area 
projection of the strain ellipsoid axes. Circles are
the axes calculated from all 8 sections, diamonds
with section 6 removed. Red = SMax, green = RInt,
blue = RMin. 
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6.3.1 Lineation data

Shan’s (2008) method for ellipsoid calculation allows the use of stretching lineation (principle axes) 
data in addition to ellipse data, that is, using sections that contain only the orientation of the section 
ellipse and not its axial ratio. Vollmer (2010) conducted tests of the lineation method using data from 
Owens (1984). The first test used the eight section ellipses in their original orientations, but constructed
from the calculated best-fit ellipsoid. These idealized sections should, therefore, return the same final 
ellipsoid as calculated from the section ellipse data. Ten combinations of two ellipses (excluding those 
that were close in orientation) and six lineations were used to calculate an ellipsoid. As shown in Table
7, the calculations correctly return the correct ellipsoid within small errors. This affirms the calculation 
in theory.

The same sections were then used with the original input data to see if the same calculated ellipsoid 
would be returned. In this case the resulting calculated ellipsoids were variable, particularly in axial 
ratios (Table 8, Figure 80). While a limited test, it shows that natural samples using only two sectional 
ellipses with additional lineation data will not produce reliable results. At present it is recommended 
that a minimum of three section ellipses, at high angles to one another, should be used, which may be 
supplemented by additional lineation data.
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Table 7. Results of test of ellipsoid-fitting using two ellipses and six lineations from 
synthetic section ellipses calculated from b* (Figure 74). For ten tests six of the eight RTj
values were omitted. Subscripts indicate the sections with RT j data. Results are all 
identical down to round-off error.

Axis bT14* bT24* bT34* bT45* bT46* bT47* bT48* bT56* bT57* bT58*
S1 2.569 2.570 2.570 2.570 2.569 2.569 2.570 2.568 2.568 2.570
t1 35.060 35.100 35.010 35.180 35.030 35.030 35.010 35.230 35.220 35.010
p1 10.900 10.910 10.890 10.930 10.900 10.900 10.890 10.940 10.940 10.890
S2 1.130 1.131 1.130 1.132 1.130 1.130 1.130 1.133 1.133 1.130
t2 127.450 127.490 127.400 127.570 127.420 127.420 127.400 127.620 127.610 127.400
p2 12.210 12.200 12.220 12.190 12.220 12.220 12.220 12.180 12.180 12.220
S3 0.344 0.344 0.344 0.344 0.344 0.344 0.344 0.344 0.344 0.344
t3 264.450 264.440 264.450 264.440 264.450 264.450 264.450 264.440 264.440 264.450
p3 73.510 73.520 73.510 73.520 73.510 73.510 73.510 73.520 73.520 73.510
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Figure 80. Test of ellipsoid-fitting using two ellipses and six lineations from eight measured 
section ellipses (Table 8). For ten tests six of the eight Rj values were omitted. Subscripts indicate
the sections with Rj data. Results are highly variable, especially as axial ratios.

Table 8. Test of ellipsoid-fitting using two ellipses and six lineations from eight measured
section ellipses (Figure 72). For ten tests six of the eight Rj values were omitted. 
Subscripts indicate the sections with Rj data. Results are highly variable, especially as 
axial ratios, which are plotted in Fig. 80.

Axis b14* b24* b34* b45* b46* b47* b48* b56* b57* b58*
S1 nan 3.422 4.379 3.196 3.389 3.371 3.469 3.126 3.301 3.127
t1 nan 41.760 47.150 43.140 20.310 20.330 20.320 42.680 45.960 37.500
p1 nan 11.690 12.580 12.310 8.060 8.060 8.060 12.240 12.790 11.280
S2 nan 0.902 0.836 1.052 0.584 0.585 0.578 0.301 1.054 1.021
t2 nan 133.950 139.230 135.430 235.100 234.930 235.570 264.470 138.190 129.850
p2 nan 10.430 9.240 10.370 80.220 80.240 80.160 73.780 9.730 11.610
S3 nan 0.323 0.273 0.297 0.505 0.507 0.499 0.561 0.287 0.313
t3 nan 264.630 264.590 264.450 111.090 111.110 111.110 264.470 264.450 264.490
p3 nan 74.230 74.300 73.800 5.510 5.470 5.600 73.780 73.830 73.700
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7. Data Transformation
The Transform Data dialog (Figure ) allows sequential homogeneous coordinate transformations of the 
data, including applying a strain, unstraining (retrodeforming), shear, rotation, and translation. 
Transformations can be sequentially applied, and undone. Selecting Accept applies the transformation 
to the data set.

The Rectify option is used to keep the data rectified to an image. See Section 3.1 for an example 
application.

8. Data Synthesis

9. Image Processing
While the manual outlining of particles is generally necessary, image processing can assist in detecting 
object outlines. EllipseFit includes an Image Filters dialog that implements some common image 
filters, and an Edge Detection dialog that implements edge detection algorithms (e.g., Efford, 2000; 
Parker, 2011).  

9.1 Filtering
Contrast – Linearly rescales the image pixels using contrast (gain) and lightness (bias) values. The 
range can also be thresholded using the black and white threshold sliders.

Normalize – Rescales the pixels to use the whole available range of values, making dark colors darkest
possible and light colors as light as possible.

Threshold – Sets pixels with intensities below the black threshold to black, and pixels with intensities 
above the white threshold to white.
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Figure 81. The Transform Data dialog which allows the 
sequential application of homogeneous coordinate 
transformations, strains, rotations or translations, to the 
data..
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Remap – Does a linear rescaling by setting the gain and bias to rescale the image pixels to the black 
and white thresholding values. 

Lightness – Increases or decreases the perceived lightness of the image. 

Intensity – Increases or decreases the values of the pixel intensities. 

Grayscale – Converts color values to grayscale.

Negative – Inverts the pixel values.

Sharpen – Adds contrast between pixels to enhance edges.

Blur – Applies a radial blur applies a blur, so each pixel is merged with pixels within the specified 
radius. 

Median - Computes the median of colors around each pixel.

Convert BW – Converts pixels with low intensities to black, and pixels with high intensities to white.

Invert BW – Converts pixels with low intensities to white, and pixels with high intensities to black.

9.2 Edge Detection
Laplacian - Convolves the pixels by a symmetric kernel to approximate the second-order derivative of 
the intensity.

Contour - Computes a contour, as if the image was drawn with a 2 pixels-wide black pencil.

Prewitt – Convolves the pixels by a pair of asymmetric kernels to enhance the gradient in the X and Y 
directions.

Sobel – Convolves the pixels by a pair of asymmetric kernels to enhance the gradient in the X and Y 
directions. This is similar to Prewitt, but gives the first-order derivatives of the intensity. 

Kirsch – Convolves the pixels using eight asymmetric kernels to enhance the gradients. 

DoG – Performs weighted difference of Gaussian edge detection.
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History
3.4.0.14 - 08 Jul 2017
• Consolidated plot image saving to Export Image As command.
• Added eps and dxf image export. Note these formats do not support all options, better results may be obtained 

by exporting as svg.  
• Fixes to Synthesize Data dialog.
• Added Modified flag to data window.
• Fixed Transform Data dialog to allow shear strain, translations, and rotations.
• Added Windows menu list of plot windows.
• Fixed bug in gnomic plot, was not setting R max.
• Added options to make it easier to scale digitizing in units other than pixels, see Section2.2.1.
• Added Export CSD command to output crystal size distribution data, see Section 2.1.3.
• Added Save command in addition to Save As.
• Fixed Save As command to rename graph and data windows.
• Added optional tick marks to polar and Rf/phi plots.
• Extensive rewriting of the user manual.
• Added Fry, polar, and Rf/phi toolbar icons.
• Replaced Wellman and Stretch centered least-squares ellipse fitting with more robust constrained least squares 

fitting.

3.3.0.62 - 14 Mar 2017
• Added Apply/Undo to Edge Detection dialog.
• Added Apply/Undo to Image Filters dialog.
• Added Median, Convert BW, and Invert BW image filters.
• Changed line pair fields to X11, Y11, X12, Y12, X21, Y21, X22, Y22, for line and point.
• Added Alpha1 and Alpha2 fields for directed angle of lines, and Beta for the angle between the lines.
• Fixed display of filled particle when deleted from spreadsheet.
• Added optional display of ellipse axes.
• Added Area field to ellipse spreadsheet. 
• Fixed bug in Image Filters histogram.
• Added Windows Taskbar icons.
• Changed messaging procedures from PostMessage to Dispatch to fix display bugs (the data window was not 

reliably updating display of the data after opening a data file). 
• Added Fit Void command and dialog box for void fitting routines. 
• Added exponential edge detection, density gradient, weighted least-squares void fitting methods with variants.
• Added bootstrapping to exponential edge detection, and enhanced normalized fitting methods.   
• Fixed control heights in dialog boxes.
• Added Edit metadata command to edit file metadata, initial lines in file beginning with “//”.
• Image Transform command dialog rewritten with fixes.
• Data Transform command dialog rewritten with fixes.
• Image Filters command dialog rewritten with fixes.
• Reorganized menu structure.
• Implemented transform data undo stack using data copies instead of inverse transforms.
• Now reopens last open files if possible. 

3.2.2 - 26 Oct 2015
• Fixed listbox display in Preferences dialog.
• Fixed bug with non-roman unicode characters in drive name. Workaround is to run from thumb drive.
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• Maintenance upgrade compiled with Lazarus 1.4.4. 
• Improved redraw speed of images when digitizing. Further optimization may be possible in subsequent 

versions. Thanks to Gabriele Casale, Appalachian State University, for reporting the issue.
• Fixed display of symbols on Ratio Plot. Changed labels from A, B, C to Max, Int, and Min.

3.2.1 - 05 Aug 2015
• Cleaned up main preferences dialog control placements, and tooltips.
• Fixed bug causing jump of preferences dialog on preview.
• Optimized data grid display scrolling.
• Changed “N” column header to “ID”. ID is a unique integer assigned to identify a single particle. Files will 

read in correctly with either “N” or “ID”, but will be written with “ID”.
• Modified desktop icon.
• Replaced term “graph” with “plot” in menu and manual.
• Work on user manual.
• Implemented opening of multiple data files with associated data plots. File > New and File Close commands 

added. 
• Default view is now the Data Window instead of Image Window. 
• Open Data and Open Image shortcuts swapped. 
• The last Open Data and Open Image paths ares now saved.
• Fixes to Nadai and Flinn plots.
• Optimized messaging.
• Added warning dialog to Reset Preferences.

3.2.0 - 28 Jan 2015
• Prevented redrawing of data on image when adding or undoing digitized points to speed up redraw with 

numerous data points or slow processors. 
• Replaced StringGrid with DrawGrid and with numerous related internal modifications in viewing and updating

the data grid.
• Enabled status bar in Data Window.
• Changed SendMessages to PostMessages.
• Fixed enabling of Ratio Graph.
• Added multiple selections in Data Window. Use Command/Control click for adding or removing items, and 

Shift click to extend selection.
• Added multiple selections in Image Window. Use Command/Control click for adding or removing items.
• Added multiple selections to Rato, Flinn, Nadia, Polar, Rf / phi, Wellman and Stretch Graphs. Use 

Command/Control click for adding or removing items. 
• Added multiple selections on Strain Map. Use Command/Control click for adding or removing items. 
• Fixed Rf / phi Save As and Export commands.
• Added Select All, Select None, Select Inverse commands.
• Known bug: Audio alerts do not work in Linux.
• Known bug: Menu commands do not initially update in the Data Window. Work around is to click on Image 

Window and back to the Data Window.
• Trying to use File > Open Image (instead of File > Open Data) to open a data file now gives a warning dialog 

with the option to open it as a data file.
• Numerous changes to Analyse > Synthesize Data command. Particle ratios are randomly selected from a range

RMin...RMax on Ln(R), or from a Gaussian distribution on Ln(R) with a mean of Ln(RMean) and standard 
deviation of Sigma. Area can also be selected from a Gaussian distribution with a mean area of pi. Orientations
are selected randomly from either a range in phi or from a Von Mises distribution.  

• Fixed settings dependancies in Fry Panel of Preferences Dialog.
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• Added Delaunay triangulation and Voronoi graphs to Strain Map options. 
• Added Delaunay nearest neighbor option to Fry Graph.

3.1.1 - 06 Nov 2014
• Added the ability to open Microsoft Excel XLS (legacy) and XLSX formats, in addition to OpenDocument 

ODS spreadsheet, and delimited file (CSV, TSV) formats. In each case, a comment line starts with '//', and a 
header row identifying the data columns must precede the data rows.

• Fixed bug requiring “Max”, “Min” data and header as well as “R” for ellipsoid calculation. Also now allows 
“Pitch” header in place of “Phi”. Thanks to Kurt Burmeister for reporting this.

• Replaced timers with event messaging.
• Fixes to Analyze > Data Synthesis command, which failed in Windows. The collision tests counts have been 

increased to 10,000 x 10,000, which tightens adjacent particle contacts. 

3.1.0 - 04 Jun 2014
• Added bootstrap error analysis to ellipsoid calculations. This has some similarities to the kernel density 

estimation approach of Mookerjee and Nickleach (2011).
• Added saving of the ellipsoid axes orientations for plotting on spherical projections in Orient.
• Changed column headers A, B, C to Max, Int, Min to clarify the axial lengths. EllipseFit will open files with 

the old headers, but will save them using the new headers.
• Removed option to save files as “Space Delimited”. This format potentially causes issues parsing files with 

spaces in the header column. EllipseFit will still open space delimited files with recognizable headers.
• Added 95% confidence regions to Nadai graph.
• Added 95% confidence regions to Flinn graph.
• Added option to save bootstrap ellipsoid axes.
• Added numerous options to Synthesize Data command. These include generating the strain ratio from a 

Gaussian normal distribution, generating particle size from a Gaussian normal distribution, generating a 
preferred orientation from a Von Mises circular distribution,  generating centers at a truncated Poisson 
distribution. The latter is performed by randomizing the location in x, y and discarding collisions.

• Added an option to the Strain Map command to either plot scaled strain ellipses or particle axes.
• Implemented the maximum mean log likelihood function (MLLF) search procedure of Shan and Xiao (2011). 

This gives a high accuracy strain estimate from Fry-type data, that is, data from truncated Poisson 
distributions. It does not require ellipse data, and it is not subjective and is reproducible. 

• Fixed auto-scaling on Fry graphs.
• Significant progress on the User Manual.

3.0.3 - 13 May 2014
• Added transforms to image to rotate, flip, strain, unstrain, etc. To strain or unstrain both image and data, 

transform the image first. This calculates the origin offset in the new bitmap. Then transform the data at (X0, 
Y0) = (0.0, 0.0) with “Rectify” checked.

• Added transform data to Wellman-type data.
• Changed default bootstrap resamples from 300 to 5000.
• Rewrote ellipse standard error and confidence interval methods. Changed from using resample trials to 

calculate standard error and Student T for confidence interval, to use resampled data for both. Non-bootstrap 
MRL uses analytical error and Student T following Mulchrone (2005).

• Added option to save bootstrap resample ellipses.
• Added option to plot 95% confidence regions on polar and Rf / phi graphs using analytical error.
• Fixed bug that was swapping A and B radii while digitizing polygons.

3.0.2 - 21 Apr 2014
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• Fixed bug in fill ellipse routine causing hangs at high thresholds.
• Fixed bug causing crash when opening page size dialog.
• Added strain map.
• Added synthesize data to create data sets.
• Added transform data to strain, unstrain, shear, etc., data.
• Changed names of digitize routines to reflect the objects, e.g., center points, ellipses, polygons, instead of the 

results (e.g., polygon moment ellipse).
• Changed names of graphs to more common specific names attributing authors, Fry, Flinn, etc., instead of 

generic names.
• Internal change in form communication, from flags and timers to messages.
• Numerous additional fixes and changes.

3.0.1 - 06 Apr 2014 
• Fixed bug effecting symbol colors in svg graphics.
• Cleaned up the polar graph.
• Fixed cursor status strings on graphs.
• Fixed up contouring preferences.
• Added axial ratio Flinn type graph. 
• Added octahedral Nadai-Hsu type strain graph. 
• Added ellipse digitizing with polygon fill and moments.
• Fixed file save warning.
• Numerous internal changes.

3.0.0 - 24 Mar 2014
• First public release of Version 3.

3.0.0.28 - 01 Aug 2012
• Initial prerelease of Version 3.
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